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Preface About This Guide

The InQuira Language Workbench is the InQuira 8.2.2 application used to ensure InQuira
Intelligent Search continuously returns the best possible answers to a user query as your
company’s needs and content change.

The Language Tuning Guide reviews the following tools within InQuira Language
Workbench used to tune the Dictionary:

e Dictionary Manager
e Test Drive
e Quality Monitor

For information on additional tools and features of the Language Workbench, please see
Intelligent Search Optimization Guide.

Intelligent Search Language Tuning Guide 1
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In This Guide

In This Guide

The InQuira Language Tuning Guide is divided into the following sections:

Chapter 1, The Language
Workbench

Chapter 2, Dictionary Manager

Chapter 3, Test Drive

Chapter 4, Quality Monitor

Chapter A, Supplementary
Tables

Contacting InQuira

Describes the InQuira Language Workbench that
contains the tools used to tune your search results.

Describes the InQuira Dictionary Manager accessed
from within the Language Workbench that allows you
to customize and maintain the Dictionary Objects used
by InQuira Intelligent Search.

Describes the Test Drive component accessed from
within the Language Workbench that allows you to test
language processing and the effects of changes made
in Dictionary Manager prior to committing to the
Central Repository and synchronizing.

Describes the Quality Monitor accessed from within
the Language Workbench that allows you to evaluate
and monitor the quality of search results. You can use
Quality Monitor and the Grading Tool to analyze
unsatisfactory search results, identify problems with
Dictionary Objects, gaps in your company’s content,
and tune InQuira Intelligent search accordingly.

Contains the supplementary tables and information to
the previous chapters

You can contact InQuira by mail, telephone, fax, and email.

Address: InQuira, Inc.

900 Cherry Ave., 6th Floor
San Bruno, CA 94066

Telephone: (650) 246-5000
Fax: (650) 264-5036
Email: For sales information, send email to sales@inquira.com.

For product support, send email to support@inquira.com.

World Wide Web: Learn more about InQuira products, solutions, services, and support

on the world wide web at: www.inquira.com.

Intelligent Search Language Tuning Guide
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InQuira Product Documentation

InQuira documentation is available only to licensed users of our software products and
may not be redistributed in any form without express permission from InQuira, Inc.

The InQuira documentation is available in PDF format.Customers can download the
PDF files from:
http://documentation.inquira.com/

NOTE: You need a PDF reader application installed on each processor on which you plan
to view the InQuira product documentation. The Adobe Acrobat reader is available
from Adobe Systems at: http://www.adobe.com.

Detailed information about each product document set is available in:

Intelligent Search Documentation on page 2
InQuira Analytics Documentation on page 4
Information Manager Documentation on page 4
Contact Center Documentation on page 5

If you encounter a problem, need help using the documentation, or want to report an error
in the content, please contact InQuira Customer Support.

If you need help obtaining InQuira product documentation, or want to obtain permission
to redistribute a portion of the contents, please contact your InQuira account
representative.

Intelligent Search Documentation

Intelligent Search is distributed with the following documentation.

Document Number Description
Intelligent Search 1S80-1G-00 This guide is intended for technical staff who are
Installation Guide responsible for installing InQuira 8.2. It provides

detailed information on installing InQuira 8.2 and
configuring the application on a single processor
using the Installation Configuration Environment

facility.
Intelligent Search IS80-CA-00 This guide is intended for system and application
Administration Guide administrators who need to configure an InQuira

8.2 application in an enterprise environment. It

describes InQuira 8.2 integration, development,
configuration, and maintenance processes and
tasks.

Intelligent Search Language Tuning Guide 3



INQUIRAW

InQuira Product Documentation

Intelligent Search
Language Administration
Guide

IS80-LA-00

This guide is intended for business users and
subject matter experts who need to create and
maintain the language processing elements of an
InQuira 8.2 application using the System Manager.
This book provides usage information about the
System Manager, conceptual information about
the InQuira 8.2 language objects, and task
information about the process of managing the
user experience provided by the InQuira 8.2
application.

Intelligent Search
Language Tuning Guide

IS80-LD-00

This guide is intended for application developers
who need to create and maintain advanced
InQuira 8.2 language-processing elements using
the Dictionary and other InQuira Language
Workbench applications.

Intelligent Search
Optimization Guide

IS80-AG-00

This guide is intended for application developers
who need to implement InQuira 8.2 advanced
features, including Personalized Navigation and
Process Wizards.

Intelligent Search
Application Development
Guide

IS80-API-00

This guide provides information about integrating
and customizing the InQuira 8.2 Personalized
Response User Interface.

Intelligent Search
Language Reference

IS80-LRG-00

This guide is for language developers
implementing InQuira 8.2 applications that utilize
the intent libraries and advanced language
processing functions. These guides are published
as separate documents that provide reference
information for each industry-specific intent library.
Each reference also contains complete
descriptions of InQuira Match Language and
Variable Instantiation Language.

Intelligent Search User
Interface Guide

IS80-UI-00

This guide is intended for application developers
who need to customize the InQuira 8.2
Personalized Response User Interface, and
integrate it with a production web application. It
contains information about the elements and
features of the User Interface, and provides
guidelines for integrating it into an enterprise web
architecture, customizing its appearance and
functionality, and implementing various special
features.

Intelligent Search Language Tuning Guide
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InQuira Analytics Documentation

InQuira Analytics is distributed with the following documentation.

Document Number Description
InQuira Analytics IA80-1G-00 This guide is intended for technical staff who are
Installation Guide responsible for installing InQuira Analytics. It

provides detailed information on installing and
configuring the InQuira Analytics product for use
with an InQuira 8.2 application.

Analytics User Guide IA80-CA-00 This guide is intended for systems and application
administrators who need to configure the Intelligent
Search and Information Manager Analytics
components to report on InQuira 8.2 application
performance.

Information Manager Documentation

InQuira Information Manager is distributed with the following documentation.

Document Number Description
Information Manager IM80-1G-00 This guide is intended for technical staff who are
Installation Guide responsible for installing InQuira Information

Manager. It provides detailed information on
installing and configuring the Information Manager

product.
Information Manager IM80-CA-00 This guide is intended for systems and application
Administration Guide administrators who need to configure and

administer an InQuira Information Manager
application, and integrate it with an InQuira 8.2
application. It also contains information for general
business users who need to use the Information
Manager to create and manage content.

Information Manager IM80-AG-00 This guide is intended for technical staff who are
Content Authoring responsible for authoring content in InQuira
Guide Information Manager. It provides detailed

information on creating content and managing
workflow tasks in the Information Manager console.

Information Manager IM80-WSR-00 This guide is intended for application developers
Developer’'s Guide who need to integrate Information Manager content,
content category, and user and security functions
with external applications. It contains reference
information and examples for all packages, classes,
methods, and interfaces of the Information Manager
Web Services API.

Intelligent Search Language Tuning Guide 5
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Contact Center Documentation

The InQuira 8.2 contact center products are distributed with the following documentation.

Document Number Description

Contact Center Advisor | CA80-1G-00 This guide is intended for application developers
Integration Guide and systems administrators who need to plan for
and integrate the InQuira Contact Center Advisor
with an InQuira application and a supported CRM

application.
Intelligent Search Siebel | CAS80-1G-00 | This guide is intended for application developers
Integration Guide and systems administrators who need to plan for

and integrate InQuira 8.2 with Siebel 7 Enterprise
Applications using the Siebel Adapter for InQuira
8.2.

Screen and Text Representations

The product screens, screen text, and file contents depicted in the documentation are
examples. We attempt to convey the product's appearance and functionality as accurately
as possible; however, the actual product contents and displays may differ from the
published examples.

References to World Wide Web Resources

For your convenience, we refer to Uniform Resource Locators (URLS) for resources
published on the World Wide Web when appropriate. We attempt to provide accurate
information; however, these resources are controlled by their respective owners and are
therefore subject to change at any time.

6 Intelligent Search Language Tuning Guide
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Chapter 1 The Language Workbench

The InQuira Language Workbench is the InQuira 8.2.2 application used to ensure InQuira
Intelligent Search continuously returns the best possible answers to a user query as your
company’s needs and content change.

The Language Workbench is comprised of six components:

Dictionary Manager on page 13
Personal Navigation on page 14
Test Drive on page 15

Quality Monitor on page 16
User Manager on page 16

For the purpose of language tuning we focus on key aspects of Dictionary Manager, Test
Drive, and Quality Monitor in this guide. For more information on other InQuira
Language Workbench components please see Intelligent Search Optimization Guide.

Intelligent Search Language Tuning Guide 9
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Opening InQuira Language Workbench

To access InQuira Language Workbench:
e From the development environment, open the Installation Configuration Environment.

In Windows select: Start>InQuira 8.1>MLD Development >Indexing
Environment>ICE

For Unix/Linux: Start Shell, use “cd” to go to the instance directory, type “sh
setenv.sh”

IMPORTANT: We recommend that you perform language development only in the content
processing instance of the development environment.

10

e Enter the following command at the Installation Configuration Environment command
prompt: workbench (workbench .sh for Unix/Linux systems).

[ QuiraBank {default) En¥ironment
Setting CLASSPATH:

Prepending InQu

C:nInQuira_B_1_2%1lib%ice. jar
C:xInQuira_8.1.2%1ib~urapper. jar

Inguira—-InQuiraBank is running.
ERROR: The autoimport*_xml files cannot he merged in while the serwvice is punnin
g. Stop the service and try again.

—Hi - +tManagementServer —HX¥:MaxHeapSize=1677721680 —3¥:+PrintCommandLineFlags —®3:
+PrintGC —XH:-+TraceClasslUnloading —KH:+UseParallelGC

You are using: InQuira 8.1.2_81<89>

in this dewvelopment environment.

InQuira C:~InQuira 8.1 _2%instances“InQuiraBank—>workhbhench

Intelligent Search Language Tuning Guide



Opening InQuira Language Workbench |NQU|RAM

The InQuira Language Workbench launcher displays:

INQUIRA

Flease enter your login information below.

User Hame: [l

Application: [M=GGESSEELE

8.1 (build 20

e Enter a valid User Name and Password.
The default user name is Administrator. The default user password is Administrator.

For more information on creating User Names see the Intelligent Search Optimization
Guide.

e Select the application for InQuira Language Workbench to open from the drop down
menu. The default is Dictionary Manager or the last application started.

NOTE: All InQuira Language Workbench applications are accessible after InQuira
Language Workbench is opened.

e Select Log In.
The Language Workbench opens to the selected application.

Intelligent Search Language Tuning Guide 11
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In the Language Workbench, you use the Application Icon Bar to navigate to other
InQuira Language Workbench applications.

N P VD el

User Manager

Quality Monitor

Test Drive

Personal Navigation

Dictionary Manager

El Dictionary Manager - Author: Language User

& e

F= ¥ Ed &

Application Icon Bar

12 Intelligent Search Language Tuning Guide
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Dictionary Manager

After opening the InQuira Language Workbench to Dictionary Manager, or by selecting
the Dictionary Manager icon from inside the application, the following screen displays:

Hi Dictionary Find Tool

on any dake/none il
A
—
ary |

Dictionary Manager is used to create, find, and tune Dictionary Objects such as concepts,
rules, and intents that determine what results InQuira Intelligent Search returns as the best
possible answer to a user query.

For more information see Dictionary Manager.

Intelligent Search Language Tuning Guide 13



INQUIRA. Personal Navigation

Personal Navigation

After opening the InQuira Language Workbench to Personal Navigation, or by selecting
the Personal Navigation icon from inside the application, the following screen displays:

[ Perzonalized Mavigation Setup

B @ DOC_TYPES

B} CoLLECTIONS
[M Instal 73 Docs
[M Instal Docs
Chinese
[nZuira Anabytics Instalabon

Personal Navigation is used to define and create taxonomies to classify your content and
facets in InQuira Intelligent Search results.

For more information see Intelligent Search Optimization Guide.

14 Intelligent Search Language Tuning Guide
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Test Drive

After opening the InQuira Language Workbench to Test Drive, or by selecting the Test
Drive icon from inside the application, the following screen displays:

F. Test Drive

Test Drive is used to test language processing and the effects of changes made in
Dictionary Manager prior to affecting the live User Interface. Test Drive provides detailed
information about Dictionary Objects and language analysis processing, associated with
the response to an individual question.

For more information see Test Drive.

Intelligent Search Language Tuning Guide 15
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Quality Monitor

After opening the InQuira Language Workbench to Quality Monitor, or by selecting the
Quality Monitor icon from inside the application, the following screen displays:

W Quality Monitor

orkbench
Question Sets (0)
: E Test Profiles

Quality Monitor is used to evaluate the quality of the answers returned by InQuira
Intelligent Search.

For more information see Quality Monitor.

User Manager

After opening the InQuira Language Workbench to User Manager, or by selecting the
User Manager icon from inside the application, the following screen displays:

f*s! Uzer Accounts
B

I |
(-3 [Administrator Adrninistr atar
[+ [11 Synch im_synch

NE PN

User Manager is used to create and set permissions for Language Workbench users. For
more information see Intelligent Search Optimization Guide.

16 Intelligent Search Language Tuning Guide



Chapter 2 Dictionary Manager

The InQuira Dictionary Manager is a component accessed from within the Language
Workbench that allows you to customize and maintain the Dictionary Objects used by
InQuira Intelligent Search to return the best possible answers. To access Dictionary
Manager see Dictionary Manager on page 13.

This chapter describes the following Dictionary Objects:

Concepts on page 17.

Clusters on page 45.

Intents, Intent Hierarchies, Intent Responses on page 50.
Rules on page 69.

This chapter also explains:

Finding Dictionary Objects on page 100.

Commit Dictionary Changes to Central Repository (vcroot) on page 103.
Update Dictionary from Central Repository on page 109.

Validate Dictionary on page 110.

For more information on additional features of the InQuira Dictionary Manager not
included in this book, please see Intelligent Search Optimization Guide.

Concepts

Concepts are Dictionary Objects that define meanings of words and phrases that occur
both in user queries and in your company's crawled content. Concepts are unique,

Intelligent Search Language Tuning Guide 17



INQUIRA. Concepts

symbolic, abstract representations of meaning. By creating a list of synonyms, a Concept
can represent multiple words and phrases that have the same meaning within the context
of your company’s business.

Creating Concepts in Dictionary Manager allows InQuira Intelligent Search to:

e Treat multiple words and phrases with the same meaning, regardless of language type,
as instances of a single Concept.

o Create relationships and clusters of ideas that expand, contract, or create associations
between other words and phrases that have been created as Concepts.

e Establish different levels of importance with respect to search. Concepts can be set to
high, mid, or low, indicating how relevant they are for the purposes of returning search
results.

When a user query is analyzed, InQuira Intelligent Search looks at each word in the query
and determines whether it matches any synonyms or Clusters of the Concept in the
Dictionary. (Clusters are discussed in the following section Clusters on page 45). If there
Is a match, Intelligent Search annotates each word or phrase with the associated
Concept(s). Simultaneously, Intelligent Search annotates your company’s crawled content
with the appropriate Concepts. Matches on the exact string of the Concept are considered
the strongest, followed by alternative forms of the word, and then associated synonyms,
for example:

- A noun matches on the corresponding plural form. Manager->managers

- A verb matches on the corresponding conjugated form. Install->installed, installs,
installing

- An adjective matches on the corresponding comparative and superlative form.
Low->lower, lowest

NOTE: Matches on Concepts that are connected as Clusters are also considered, but with
less scoring weight.

18

For example, a search on “dictionary” first matches on “dictionary”, followed by any
variations of the word, such as; “dictionaries.” After these, InQuira Intelligent Search
matches on any synonyms listed to the Concept “dictionary” such as “lexicon,” “lexicons”
“glossary,” or “glossaries.” Finally, any Clusters or relationships that have been
established match. These may include, for example, “ontology”, “concept,” “dictionary
manager.”

In addition to determining how an unstructured search is conducted, Concepts may also be
used to write Rules and Intents.

For information on the features of Concepts listed under the Advanced menu, please see
Intelligent Search Optimization Guide.

Intelligent Search Language Tuning Guide
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Role of Concepts in Unstructured Search Results

A Concept has three features which play a role in evaluating potential search results in the
indexed content:

- Concept Level
- Synonyms
- Clusters (discussed in Clusters on page 45.)

For example, suppose the user query is “closing the dictionary manager.” this query may
be annotated with the Concepts <close> and <dictionary manager>. (Concepts are
indicated by angle brackets.) The query is not annotated with <manager>, as the complete
phrase is considered a better match.

These annotated Concepts may have the following features:

<close>

Concept level: low

Synonyms: close, close down, shut

Clustered with: <switch off> (synonyms: switch off, deactivate)

<dictionary manager>

Concept level: high

Synonyms: dictionary manager

Clustered with: <workbench> (synonyms: workbench)

When InQuira Intelligent Search evaluates a document to determine how well it matches a
user query, these are two of the criteria used:

NOTE: The following assume the effects of the criteria if all other scoring procedures are
equal.

1. How close the word or phrase in the content matches the annotated Concept from the
user query:

a) Best match: The content is annotated with the same Concept, and has the same
form. For example, “closing” on “closing.”

b.) Next best: The content is annotated with the same Concept, but has a
alternative form. For example, “closing” matches on “closes.”

c.) Next best: The content is annotated with the same Concept, but uses an
associated synonym. For example, “closing” matches on “shut” or “shutting.”

Intelligent Search Language Tuning Guide 19



INQUIRA. Concepts

d.) Next best: The content is annotated with a Concept that is clustered with a
Concept annotated in the query. For example, “dictionary” matches on
“ontology” which is annotated with the Concept <ontology>, clustered with
the Concept <dictionary>.

e.) Next best: A literal match between word forms which are not annotated with
related concepts. For example matching “dictionary” from a user query of
“dictionary manager” with “dictionary” in a piece of content such as
“dictionary objects.”

2. The weight of each Concept match (high, medium, or low).
- First result: “How to close the dictionary manager”

“closing” has a low level Concept match on “close” as described in 1b.
“dictionary manager” has a high level Concept match on “dictionary manager”
as described in 1a.

- Second result: “Closing the workbench”

“closing” has a low level Concept match on “closing” as described in 1a.

“dictionary manager” has a high level Concept match on “workbench” as
described in 1d.

- Third result: “Deactivating a workbench account”

“closing” has a low level Concept match on “deactivating” as described in 1d.

“dictionary manager” has a high level Concept match on “workbench” as
described in 1d.

- Fourth result: “Setting up the dictionary manager”

“closing” has no match.

“dictionary manager” has a high level Concept match on “dictionary manager”
as described in 1a.

- Fifth result: “Deleting closed and ignored tasks”

“closing” has a low level Concept match on “closed” as described in 1b.
“dictionary manager” has no match.

The ordering of these results reflects the overall closeness of the match between query and
content. For example, the first result scores higher than the second result because it has the
best match on :dictionary manager:, which is annotated with a high level Concept;
whereas the second result matches on “closing”, a low level Concept. The fourth and fifth
results are ranked last because they each only have one match, but the fourth result is
ranked higher because the match is on the Concept with the higher level, <dictionary
manager>. The net effect is to produce an ordering which corresponds to actual relevancy
of the result to the user’s query.
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In addition to determining how an unstructured search is conducted, Concepts may also be
used to write Rules and Intents. See Role of Concepts in Rules and Intents.

Adjusting the Importance Level of Concepts

If you are not getting the desired best match and you have ruled out other language tuning
issues, try downgrading the importance level of a high concept to medium to see if that
helps resolve the issue. Sometimes decreasing the importance level of a concept improves
search accuracy.

The three importance levels that are assigned to concepts—high, medium, and low
contribute to the overall score that a document receives by being matched to the Search
Component rules RequiredConcept SC, VerylmportantConcept SC, and ImportantConcept
SC, respectively. These rules contribute the following points when they match:

Importance Level Points
High 100,000
Medium 10,000
Low 1,000

Since a high level concept adds substantial points to the overall score of the document, it is
important to assign this level only to concepts that are likely to produce meaningful
matches to documents from the search perspective. Concepts that appear in many
documents without discriminating the content of the document need to be assigned to
lower levels of importance. For example, the name of a company, which may appear in
every document without adding anything to the content of the document or identifying it
as relevant.

For this reason, sometimes search results are improved when a concept is moved from
high down to medium, or medium down to low. This happens when a good match is
overtaken by less desirable matches that takes place at a higher level.

Role of Concepts in Rules and Intents

In addition to determining how an unstructured search is conducted, Concepts may also be
used to write Rules and Intents that match on user queries and provide some specific
information in addition to the unstructured search results. Concepts have three features
which can be leveraged for this purpose:

e Synonyms
e Cluster relationships
e “Type of” relationships, also referred to as a parent/child relationship.
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For example, the Information Manager is an InQuira product; this relationship can be
represented by making the Concept <information manager> a type of <inquira product>.
We may also want to cluster <information manager> with the Concept <information
center>, as they are related ideas.

Assuming this Concept hierarchy, <information manager> may have the following
features relevant to writing Rules and Intents:

<information manager>
Synonyms: information manager, im
Clustered with: <information center> (synonyms: information manager, ic) in
a Cluster object named [information manager]
Type of: <inquira product>
Using the InQuira Matching Language (IML), we can use the following expressions in a
Rule or Intent:
<information manager>
Matches on all synonyms of the Concept
[information center]
Matches on all synonyms of the Concepts which are members of this
Cluster.
CHILDREN(<inquira products>)
Matches on all synonyms of the Concepts which are a type of <inquira
product>.
Whenever a change is made to the synonyms or relationships of a Concept, any Rules or
Intents which reference the Concept change their matching behavior accordingly. For
more information on Rules, please see Rules on page 69. For Intents, please see Intents,
Intent Hierarchies, Intent Responses on page 50. For more information on the InQuira
Matching Language, please see Chapter 1, IML and VIL Reference in the Intelligent
Search Language Reference.

Basic Concept Relationships

This section discusses the following basic concept relationships:

e Parent/ Child Relationships

e Cluster Relationships

This section also provides Additional IML Tips for working with concept relationships.

Parent / Child Relationships

There are two symmetrical relationship constructs to build parent/child relationships
among concepts:
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e isatype of / has these types
e isa part of / has these parts

These relationship definitions do not influence default search results by themselves, but
can be leveraged in the rule system. For example, you can write a rule with IML
referencing CHILDREN(<concept>) to match all the direct children of that concept
(everything in the has these types field) or, you can use ALLCHILDREN(<concept>)
to match both direct children, all grandchildren, etc.

Cluster Relationships

Concepts can also belong to a cluster with other concepts. This can influence default
search results if a document contains a clustermate of a concept found in the query, that is
considered a valid match. Cluster matches are given less weight than an exact match or a
match on a synonym of the same concept. You can reference a cluster in IML with the
SIMILAR operator, e.g. SIMILAR(<concept>) matches on the synonyms of that
concept plus any concept that it's in a cluster with.

Additional IML Tips

e If you reference a concept without the CHILDREN or SIMILAR operators, then the
match is on just that concept, not on related concepts.

e Some strings are required to be the sole contents of the query (i.e. they're surrounded
by BEGIN/END), while others are not. So IML of:

BEGIN <noun.finance.401_ k> END"

matches on "401k™" as a synonym of <noun.finance.401_k>, but not if it is part of a
larger query, e.g. "my 401k". Whereas for IML "<noun.finance.401_k>", the synonym
of <noun.finance.401_k> does not have further restrictions on it, so this IML matches
"401k", but also, "my 401k™ and, "I'm writing to ask for more information about the
401k packages you offer."

Create Root Concepts

The Dictionary Manager requires at least one Root Concept to be defined in the
application configuration in order to display the Concept tree. You can configure one or
more Root Concepts using the Workbench page of the Advanced Configuration Facility.

To add or change a Root Concept in the Advanced Configuration Facility:

1. Select Workbench from the System menu of the Advanced Configuration Facility
main menu, then click Edit

The Workbench page lists any currently configured Root Concepts. The order of the
list does not affect the Concept Tree display.
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2. Under Root Convepts:, click Add New Item, or select an existing Root Concept to
modify.

The Editing: Workbench > Root Concepts page displays a blank Concept field and
Used for Analytics on/off radio buttons.

3. Enter the new Root Concept, in the Concept field or, edit an existing concept name or
analytics designation.

4. Click OK to apply your changes.
5. Click OK to exit the Editing page.
6. Click Save to save your chnages.

Create New Concept

By creating new Concepts, you allow InQuira Intelligent Search to return results that
match not only on a particular word but also their synonyms and related Concepts.

To create a new Concept:

1. In Dictionary Manager, select the H icon or New Concept from the File menu.
The New Concept window displays:

® New Concept

Base Concepks
any [

2. Name the Concept in the Name field. You may use any alpha-numeric combination.

The Concept name is used to reference the Concept in other Dictionary Objects, such
as Rules.
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NOTE: The only valid characters allowed in the name field are: letters, digits, underscores,
percent signs, single quotes, periods, spaces. You may not use special characters,
such as Chinese characters in the Name field.

3. (Optional). Enter a definition into the Description field.

The Description field is used to clarify the meaning among users, and can be used to
find dictionary objects.

NOTE: The Description field may be used as the display form of the Concept, and for that
reason it is advised to enter a display name for the Concept into the Meaning field.

4. (Optional). Enter any information regarding the Concept in the Notes field.

The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on Concept modification among users.

5. Check the Enabled box. (This is checked by default.) If the Enabled box is not
checked, InQuira Intelligent Search ignores the Concept during instances of Concept
Ambiguation.

6. Select a domain from the Domain List. For more information, see Concept Domains
on page 94. The default domain list is the last Domain List selected.

7. Select the Part of Speech from the drop down list. The part of speech is used by
InQuira Intelligent Search in stemming. It is recommended that you select ANY, unless
you need to reduce the forms of the word synonyms match.

8. Select the Concept Level from the drop down menu. The default is the last Concept
Level selected.

The Concept Level is used for scoring. High corresponds to 100,000 points or
Required, Medium to 10,000 or Very Important, Low to 1,000 or Important.

Concepts that are highly relevant to search results should be set to high. However,
Concepts that occur frequently in your company’s content such as the company name
should be set to low.
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Add Synonyms

9. Select the Synonyms tab. The Concept window with the default language synonyms
tab displays:

9a.(Optional). Complete the Preferred Values fields.

In the Synonym field, enter the preferred name of the synonym based on the
selected language.

NOTE: The Preferred Values: Synonym overrides the Concept name, and is used in
display purposes in the Ontology Navigation. For more information, see the
Personal Navigation Setup in Intelligent Search Optimization Guide.

It is recommended that you leave the Abbreviation field blank, as it has no impact
on InQuira Intelligent Search.

10.Enter all the synonyms for the Concept under has these synonyms.
Enter one synonym per line. You must enter at least one synonym.
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NOTE: You must include the name of the Concept itself as a synonym, as the Concept
name is NOT matched by default.

It is best to enter all Concept synonyms in lowercase and in their unmarked (stemmed)
form. InQuira 8.1 automatically matches the marked forms of that word, like plural
nouns or conjugated verbs. You may enter special characters, such as Chinese
characters, into the has these synonyms field.

NOTE: English and Japanese synonyms (typed in Latin characters) use a specific type of
case sensitivity regarding uppercase usage. Lowercase letters in synonyms match
on either upper- or lowercase, but uppercase letters match only on uppercase. So,
the synonym "EZPay" matches on "EZPay", "EZPAY", "EZPAy", etc., whereas
"ezpay" matches on any type of capitalization. This allows you to specify case
matching for short abbreviations that might otherwise get confused with common
words, like "OR" for "Oregon".

In other languages, a synonym with a marked form or with capitalization matches
on other forms and capitalizations of the word.

Include as synonyms only words that truly have the same meaning. If the words are
similar but not the same, it is best to create separate Concept. For example, The
Concept <web site> may have the synonyms “web site” and “web page,” but not
synonymous terms such as “home page” and “URL” belong to a different Concept.

We recommend you add common misspellings to the Spell Check List, for more
information see Spell Check List on page 43.

11.(Optional). Enter IML into has synonyms matching this IML.

Use this field to narrow the context in which a concept is annotated. For more
information on IML see Intelligent Search Language Reference.

Add Synonym Set (synset)

By adding a Synonym Set, you allow InQuira Intelligent search to return results of various
languages.
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12.(Optional.) Select Add Synonym Set to associate synonyms of another language with
this concept. The Select language of Synonym Set window displays:

Select language for Synonym Set

(24

Any

.

- Select a language from the drop down list.

NOTE: Select Any if the synonym is valid for any language. For example, Product Names,
Proper Names, Cities.

- Select OK. An additional language tab displays.

® New Concept

T

13.Complete the fields as described above in Steps 9. 10.and 11.
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Add Related Concepts

14.(Optional.) To add any relationships the new Concept has with existing Concepts.

Select the Related Concepts tab.The Related Concepts tab displays:

® New Concept

T
|

e ype o

NOTE:

You may add additional Related Concepts by selecting Add Concept relationship
from the Edit menu of the Concept Window.

Select the type of Concept relationship from the drop down menu.

- e o

is a part of

Drag and drop the existing Concept(s) you want to relate, or type the Concept
name in the Add Concept blank.

NOTE:

“Type of” and “Part Of” Concept Relationships does not affect which Concepts are
annotated by Intelligent Search or scoring unless triggered by custom Rules or
other Dictionary Objects that are created to specifically search on associated
relationships.
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Add Cluster Relationship

15.(Optional.) You may add a Cluster relationship through the Concept window For more
information on Cluster Relationships see Clusters on page 45. From the Concept
Window, select Edit, select Add Cluster relationship. The following dialog displays:

E Add Cluster Relationship

- Select Add a new Cluster. The belongs to this cluster section adds to the
Concept window.

- Drag and drop the existing Concept(s) you want to Cluster with, or type the
Concept name in the Add Concept field.

NOTE: You may also create a Cluster Object. For more information, see Clusters on
page 45.

16.Save the Concept.

Select Save from the File menu in the Concept window.

IMPORTANT: A new Concept does not affect live Intelligent Search results until you
Commit Dictionary Changes to Central Repository (vcroot) on page 103,
a full content re-index is performed, and the changes have been
synchronized to the runtime environment, for more information see
Intelligent Search Administration Guide. To see the effects of new or

modified Concepts without committing, use Test Drive with the Concept
expansion box checked.

Concept Tools

If you entered IML into the has synonyms matching this IML field, you may check the
validity of the IML prior to saving.

e Select Check IML from the Tools menu in the Concept window.
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InQuira Intelligent Search automatically checks the validity of your IML. If a problem is
detected, the IML Syntax Problem dialog displays explaining the IML error:

IML Syntax Problem

Lid

]

If no problem with the IML is detected, then the IML Syntax Correct dialog displays:
IML Syntax Comrect

Lid

—

Ontology Viewer

The Ontology Viewer allows you to see the Concept and the existing relationships it has
with other Concepts and Clusters.

To use the Ontology Viewer:
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e Select Graph from the File menu in the Concept window. The Ontology Viewer
displays:

[# Ontology Viewer i

information manager

EEEEEE

cluster

|

e You may select Part Hierarchy to switch the view mode from Type Hierarchy.
e Hovering over a Concept displays the associated synonyms.

e You may select a language from the Language menu to see the synonym set of the
Concept.
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Example of Creating a New Concept

The following screen shows the results page for a search on Information Manager prior to
the creation of an <information manager> Concept:

) Answers - Mozilla Firefox

o e | L file:/C:AnQuira_8.1 Atmpwarkbench_34 F Google

2

=

Find |information manager
Answers Example:"Does Product-¥ have Feature-v?"

» Start over

Languages: Answers Are we
» English (103} answering

= ) ) your
DocTypes: Restart the Information Manager Service questions?
b HTML (103) Restart the Information Manager Service
o O ahzolutely!
= O
Collections: E—J . ) Usua”?
v IM Install 73 Uninstall Information Manager ' Sametimes
Docs (44) Uninstall Information Manager O Hardly
¢+ IM Instal o
Docs (47) B M
L B ot even close!
' -leﬂ'?s—au.-) Installing and Configuring Information Manager s
* InQuira Installing and Configuring Information Manager Submit

Analytics

Installation {11}

about the Information Manager Installation
Guide
About the Information Manager Installation Guide

= Information Manager System Regquirements and
Dependencies
Information Manager System Requirements and
Dependencies

= Information Manager Installation Guide

= Information Manager 7.2 Installation

NOTE: Only manager is bold. Bold face words indicate what InQuira matched between
the query and the documents.
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The following screen shot of the Annotations tab in Test Drive shows that Information
Manager is being treated as two separate Concepts, despite the fact that Information
Manager is a single concept in the InQuira business context.
F. Test Drive

G firFormation manag
Default e

Medium score concept: supervisor

34 Intelligent Search Language Tuning Guide



Concepts INQU IRA.

In order for InQuira Intelligent Search to recognize that Information Manager is a single
Concept, we add and save the term as a new Concept in Dictionary Manager.

® information manager

information manager
s ————

|

Base Concepts ]
any [ rioh =]

information manager
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Using Test Drive, confirm that the Concept expansion box is checked (see Using Test
Drive on page 122 for more information), we can see the effects of creating the new
Concept <information manager>.

P Test Diive

@ firFarmation manag
Default -

After creating the Concept <information manager>, it can be seen that InQuira Intelligent
Search no longer treats the term as two separate Concepts but now as one single Concept.
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The following graphic illustrates the effect of creating a new Concept displayed on the

search results page.

infarrnation manager

- -~
& e Example:"Does Product-» have Feature-v?" Tips
Languages: ANSWErs AR
* Enalish (100 answering
=l ] ) your
DocTypes: Restart the Information Manager Service questions?
b HTML (1000 Restart the Information Manager Service
C ahsolutely!
o
Collections: _J . . USuallﬁ,.r
v IM Install 73 Uninstall Information Manager ) Sometimes
Docs (44) Uninstall Information Manager O Hardly
b IM Install o]
Dacs (47) = _ _ _ Mot even close!
r C'“L‘?'SE (1) Installing and Configuring Information Manager ——
+ InQuira Installing and Configuring Information Manager
analytics
Installation (&)
=
dhout the Information Manager Installation
Guide
About the Information Manager Installation Suide
= . e
The Information Manager Product Distribution
The Information Manager Product Distribution
= _ , :
Installing Information Manager Webh Services
Installing Information Manager Weh Services
Specifying the Information Manager Database
NOTE: The result have changed and now display “Information Manager” in bold.
Additionally, the fifth result has changed to no longer include manager
individually, as is now is recognized as a part of a larger phrase.
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Example of Creating Synonyms in a Concept
The following is the search results page returned for a query on “im”.

Concepts

38

im
i g Example:"Does Product-% have Feature-v?" Tips
1
Langu.ages: ANswWers AR e
» Enalish (13) answering
& : _ your
DocTypes: Configuring the IM Cperational Warehouse questions?
b HTML (13) Instance o
Configuring the IM Operational Warehouse Instance Absolutely!
ol
Collections: o USua”\-"r
b IM Install 73 = : ; N sometimes
Cocs (4) Fegistering a Web Application el Hardly
¥ IM Install Reqgistering a Web Application For exarmple: )

Docs () <IM_home=/<instance_name=/appserverim/webapps e e
¢ InQuira '
Analytics ]

Installation (8) | = (Creating the ODBC DSM

Creating the QDBC DEM InQuira 3.0 Analytics
Database InQuira 8.0 IM OLTP Database InQuira 5.0
Search Archive Database

= , .
Configuring the Analytics Warehouse Instance
Configuring the Analytics Warehouse Instance Qpen
Administration. Open the Database Instance Manager.
Select IM Operational Warehouse Instance

= _
Creating an ODBC DSH
Marming the data sources InQuira &.0 Analytics
Database InQuira 8.0 IM OLTP Database InQuira 5.0
Search Archive Database
Information Manager Application Configurations

These results answer the query, however at InQuira it is known that users often use “IM”
to refer to Information Manager, therefore we modify the Concept <information manager>
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to include “im” as a synonym in order to return queries on im with results related to
Information Manager.

;{
. :

Information Manager
information manager
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After creating and saving the modified Concept, we check the effects in Test Drive,
making sure Concept expansion is checked. The following search results page displays:

im
Example:"Does Product-¥ have Feature-v?"

Tips

Languages: ANSWErs
v English (107}
d

DocTypes: The Information Manager Product Distribution

The Information Manager Product Distribution
Information Manager for Microsoft Windows
install_im .exe Information Manager for Sun Solaris

b HTML {107}

40

Collections:
v IM Install 73
Docs (45) =)
v IM Install
Diocs (48]
¢ Chinese (1]
b InQuira

Analytics ]
Installation (13} —

Confiquring the IM Operational Warehouse
Instance
Configuring the IM Cperational Warehouse Instance

Restart the Information Manager Service
Restart the Information Manager Service

Uninstall Information Manager
Uninstall Information Manager

Installing and Configuring Information Manager

Installing and Configuring Information Manager

Ahout the Information Manager Installation
Guide
About the Information Manager Installation Guide

Are we
answering

your
questions?

) ahsolutely!
O Usually

O sometimes
O Hardly

O

Mot even close!

Submit

InQuira Intelligent Search matches on results that contain both “im” and “Information

Manager.”

Example of Creating a Synonym Set (synset)

In the following example, we create a Chinese synonym to the <information manager>
Concept. By creating a synset, we expect InQuira Intelligent Search to return documents

in Chinese that contain the Concept <information manager>.
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First, we add the Chinese synset to the already existing <information manager> Concept.

® information manager _ O] %]

o information manager

oo corees ]
R

After creating and saving the modified Concept, we check the effects in Test Drive,
making sure Concept expansion is checked. Considering we expect a user to enter in the
Chinese synonym for <information manager> from a Chinese-based search page, we

select the language as Simplified Chinese, and the Domain List as Simplified Chinese
Customerhelp.
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The following search results page displays: _
HHEZE EEEER

» B8 Fis TR X AT RATEE YT 100
DocTypes: =5 e I o
» HIML (1) EE 3L
Collections: - EEERER O 3'5#%*% !
v Chinese (1) EAERE Cpmits
) 58t
W <« TB1 > F—&\ O Tis
O st

INQ:.TFF?A-

NOTE: You must select the Language and Domain List according to the language of the
synset you want to test in Test Drive.
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Spell Check List

InQuira Intelligent Search has the capability to return accurate results despite spelling
errors in the user query. Intelligent Search automatically corrects most misspelled words
in all supported languages. If you find there is a common misspelling that is not corrected,
then you may add it to the Spell Check List.

In addition, you may find that proper names or foreign terms are incorrectly changed to
other words. To avoid this you may create the term as a synonym to a Concept as
described in Concepts on page 17, or add the word to the Spell Check List. Concept
synonyms are considered correct spellings and not spell corrected.

Intelligent Search uses two sets of criteria to recognize misspellings: a typographical
similarity algorithm and/or a phonetic similarity algorithm.

Intelligent Search spellchecking is case sensitive, allowing you to distinguish between
capitalized and lower case words, which may have a different meaning and therefore need
to be spell corrected differently. For example, RLOCATION and rlocation get spell
corrected differently to LOCATION and, relocation, respectively. To have a term spell
corrected differently, modify the Spell Check List.

To modify the Spell Check List:

1. In Dictionary Manager, select the [% icon or New Spell Check List, from the File
menu. The New Spell Check List window displays:

B New Spell Check List

2. Select a language from the drop down list in the Name field.
3. (Optional) Enter a definition into the Description field.

4. The Description field has no impact on InQuira Intelligent Search results. It is used to
clarify the meaning among users, and can be used to find dictionary objects.

5. (Optional) Enter any information regarding the Spell Check List in the Notes field.

6. The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on the Spell Check List modification among users.
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7. Check the Enabled box. (This is selected by default.) If the Enabled box is not
selected, the Spell Check List is ignored by Dictionary Manager.

8. Enter a common misspelling in the Misspelling field.
9. Enter only one misspelling of a word per line.
10.Next to the misspelled word, enter the correct spelling in the Correction field.

11.Choose whether to correct words based on case by checking the Keep Case box.
(default setting). If the Keep Case box is not checked, InQuira Intelligent Search
corrects spelling errors regardless of case.

12.Select Add a line to add more spelling corrections. Repeat Steps 8. 10. and 11.

NOTE: See <SpellCheckProperties> for the selected language. For the examples here, the
language is "en-US".<NUMBER>.xml is located in
<instance>\development\content\data\config\default. The highest number file
contains the latest configuration parameters.
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Clusters

Clusters are Dictionary Objects that allow you to group similarly related Concepts. For
example, the Concept <cat> could be clustered with the Concept <kitten>, as the two are
not strictly synonyms, but can be used with roughly the same meaning. Like synonyms of
Concepts, Clusters are matched by InQuira Intelligent Search when evaluating
unstructured search results but are assigned less scoring weight.

Creating Clusters in Dictionary Manager allows InQuira Intelligent Search to:
e Expand, contract, or create associations between Concepts.

In addition to determining how an unstructured search is conducted, Clusters may also be
used to write Rules and Intents. For more information see IML Basics on page 159.

Create a new Cluster

By creating new Clusters you allow InQuira Intelligent Search to return results that match
not only on a particular Concept, but also similarly related Concepts.

To create a new Cluster:
e In Dictionary Manager select the E icon or New Cluster from the File menu.

The Cluster window displays:

#% New Cluster

¢ Name the Cluster in the Name field. You may use any alpha-numeric combination.

The Cluster name is used to identify the Cluster. For example, a Rule may use the
Cluster name in the IML question pattern.

NOTE: The only valid characters allowed in the name field are: letters, digits, underscores,
percent signs, single quotes, periods, spaces. You may not use special characters,
such as Chinese characters in the Name field.
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46

(Optional). Enter a definition into the Description field.

The Description field has no impact on InQuira Intelligent Search results. It is used to
clarify the meaning among users, and can be used to find dictionary objects.

(Optional). Enter any information regarding the Clusters in the Notes field.

The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on Cluster modification among users.

Check the Enabled box. (This is selected by default.) If the Enabled box is not
checked, InQuira Intelligent Search ignores the Cluster.

Select a domain from the Domain menu. For more information see Concept Domains
on page 94. The default domain list is the last Domain selected.

Add the Concepts you want to cluster together by typing the Concept names into the
Add Concept field, or drag and drop the Concepts into the field.
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Example of Creating Clusters

INQUIRAM

The following screen shows the results page for a search on Information Manager.

Ask a

Question

» Start over

Languages:
v English {1067

DocTypes:
b HTML {106)

Collections:

Information Manager

Example;"Does Product-# have Feature-17"

Festart the Information Manager Service
Restart the Information Manager Service

Installing and Confiquring Information Manager

Uninstall Information Manager

The Information Manager Product Distribution
The Information Manager Product Distribution

Installing Information Manager Weh Services
Installing Information Manager web Services

-
Tips

Site Map

Browse the Site
Map

Are we

v Demo ] B answering
Cantent (13) Installing and Configuring Information Manager your
¥ IM Install questions?
Ciocs (48)
r 1M Install 73 About the Information Manager Installation © absolutely!
Docs (45) Guide C Usually
&bout the Information Manager Installation Guide ' Sometimes
) Hardly
) . O
Uninstall Information Manager Mot even close!

Submit

NOTE: The fifth answer.

In the InQuira business context we know that Information Center is the web client for
Information Manager. We can safely assume that when a user queries for Information
Manager they may also benefit from results on Information Center (and vice versa). By

creating Information Manager and Information Center as synonyms we ensure results on
both appear on the results page. However, our knowledge of the InQuira business context
and the English language dictate that although Information Manager and Information
Center are related, they do not have the same meaning. Considering the two terms are not
synonymous, we should NOT create them as synonyms. Instead, the best and simplest
way to ensure information on both Information Manager and Information Center are
returned when a user query contains either is to Cluster <information manager> and
<.information center>.
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To Cluster <information manager> and <information center>, we must first create
Concepts for both in Dictionary Manager. After the Concepts have been created, select to
Create a new Cluster. After entering a name, drag and drop both the Concepts to the Add

Concept field.
=10] x|

%% InQuira IM Products

-

Base Concepts |_

Then save the Cluster by selecting Save from the File menu. Saving the changes
automatically adds the Cluster relationship to Concepts <information manager> and

<information center>.
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After saving, we check the effects of clustering the two Concepts using Test Drive.

Languages:
» English (106)

Information Manager

Example:"Does Product-» have Feature-v?"

DocTypes:
» HTML (106}

Collections:

r Demo
Content (137

b IM Install
Docs (48]

b IM Install 73
Docs (45])

Answers

Restart the Information Manager Service
Restart the Information Manager Service

Installing and Configuring Information Manager
Installing and Configuring Information Manager

About the Information Manager Installation
Guide
About the Information Manager Installation Guide

Uninstall Information Manager
Uninstall Information Manager

Configuring Information Center Graphics and
Formatting

Canfiguring Information Center Graphics and
Formatting The Information Manager displays the
administration page

Site Map

Brawze the Site

Map

Are we
answering
your
questions?

]
Tips

) ahsolutely!
O Usually
O sometimes

O Hardly
o

Mot even close!

Submit

By comparing the InQuira Intelligent Search results we can see the effects of clustering
<information manager> and <information center>. The first four answers remain the same,
however the fifth answer has changed due to the cluster relationship. The fifth answer appears
higher in the search results as it contains both “Information Manager” and “Information Cen-
ter.” As expected, the results are not drastically changed as the scoring process used by
InQuira Intelligent Search first matches on exact matches, then synonyms, and to a much
lesser degree Clusters.
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Intents, Intent Hierarchies, Intent Responses
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Intents are Dictionary Objects that, like Rules, determine how InQuira Intelligent Search
interprets and responds to user queries. Intents are packaged, installed, and configured as
part of the industry-specific dictionaries provided with InQuira 8.2.2. default Intents were
determined through linguistic and statistical analysis of question logs from leading
industry operators. A separate intent has been created for every category that received
more than .5% of search questions.

Intents are defined by the language patterns for similar types of queries or requests. An
Intent typically captures a family of queries that InQuira Intelligent Search recognizes as a
unitary Dictionary Object. For example, The “Bill Inquiry” Intent matches on queries
about checking a bill balance, how much is owed, and payment deadlines.

Intents are associated with Intent Responses. Intent Responses are collections of answer
content and additional associated information that you can create and manage as single
entities. Intent Responses can be assigned to one or more specified Intents. For example,
the Intent Response associated with the Balance Inquiry Intent may provide instructions
on how to log in and check an account balance. To liken Intents to Rules, Intents correlate
to the question pattern condition, whereas Intent Responses are the action similar to that of
a Managed Answer Rule.

Creating Intents and Intent Responses in Dictionary Manager allows InQuira Intelligent
Search to:

e Return the best possible answers to common user queries.
e Return specific results to satisfy users queries and your company’s needs.

e Group various questions under one common intent and analyze user behavior and
improve user experience with InQuira Search Analytics reports.

Intents are organized as parent, siblings, and child nodes in an Intent Hierarchy. Intent
Hierarchies descend from a single node at the highest level called All Intents. The position
of the Intent within the Intent Hierarchy determines its precedence in being selected as an
answer to a user query. The Rules Engine selects the lowest-level matching Intent in the
hierarchy as the best possible response. If a low-level Intent does not satisfy a user query,
the Rule Engine works backwards to match on a higher-level Intent. This process, referred
to as degradation, ensures that InQuira Intelligent Search returns an appropriate Intent
Response even if there is none configured for the matched Intent. For example, the Bill
Inquiry Intent is a child of the Billing Inquiry and Support Intent. If there is no Intent
Response configured for the Bill Inquiry Intent, then the Intent Response for the Billing
Inquiry and Support Intent displays.
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NOTE: As of InQuira 8.0.4, all Intent Responses use the Answer template, which means
they all contain the title, url, picture, and text fields.

Create and Assign Intent Responses

By creating new Intent Responses, you allow InQuira Intelligent Search to return a set
answer to a variety of user queries that essentially have the same intent.

To create a new Intent Response:
1. In Dictionary Manager, select the &l icon or New Intent Response from the File
menu.

The Select Response Type dialog displays:
Select Rezponze Type

o

Yo |[L] core

- Select Yes or No. (The following instructions assume you select No.)

NOTE: If you want to create an Intent Response that uses a Process Wizard, you must have
already created the Process Wizard you intend to use. For more information on
creating Process Wizards see Intelligent Search Optimization Guide.
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:The Intent Response window displays:

New Intent Hesponse

Link
image  Image
bexk Text

2. Enter a descriptive name for the Intent Response in the Name field.

NOTE: An Intent Response cannot have the same name as an Intent or a Rule.

52

3. Select a Purpose from the drop down list.

The Purpose corresponds to display characteristics defined in the User Interface,
enabling you to establish consistent, focused and targeted presentation for various
types of content. For more information, see Purpose (portlet) on page 158.

4. (Optional.) Fill in the Description field.

The Description field has no impact on InQuira Intelligent Search results. It is used to
clarify the intended function of the Intent Response among users.

5. (Optional.) Enter any information regarding the Intent Response in the Notes field.

The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on Intent Response modification among users.
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6. Check the Enabled box. (This is selected by default.) If the Enabled box is not
checked, InQuira Intelligent Search ignores the Intent Response.

7. Select the Domain from the drop down list. Only Domains you have permission for are
displayed. The Domain field is set to the most recently saved Domain by default. For
more information on Domains, please see Non-Concept Domains on page 94.

8. (Optional.) Select a User Profile.

Click Set and select a user profile from the drop down list if you want InQuira
Intelligent Search to restrict the return of the Intent Response based on business
conditions associated with the query. To establish User Profiles see Intelligent Search
Optimization Guide.

9. (Optional.) Check the Suppress parent responses box. (This is deselected by default.)

Checking the Suppress parent responses box configures InQuira Intelligent Search
to not display Intent Responses configured for a parent Intent unless the query directly
matched the parent Intent.

10.(Optional.) Check the Suppress search box. (This is deselected by default.)

Checking the Suppress search box configures InQuira Intelligent Search to stop the
search process once an Intent associated with this Intent Response is matched.
Therefore, the search results page display only one result, the Intent Response.

11.(Optional.) Select an additional language from the Add Selected Language drop down
list.

The additional language selection refers to the language used in the specified response.
The default language is English.
Upon selecting Add Selected Language, an additional language tab displays:

* Title

* Link,
* Image
* Text

12.Enter Content Values in the Response Fields. If you want to associate the Intent
Response with an Information Manager document enter the information in the
following format in the IM Reference field: DOCID:Channel_name/@field

NOTE: Using an IM Reference makes the Information Manager document visible to all
users when the Intent Response displays.

a) Enter text in the Title Field.
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Type the text as you want to see it displayed as hypertext on the InQuira Intelligent
Search results page.

b.) Enter a complete URL in the Link field

Type the full URL link associated with the title specified above, and the optional
graphic specified below.

c.) (Optional.) Enter a complete URL in the Image filed.

Type the full URL of an image you want to appear on the InQuira Intelligent
Search results page. The image takes the URL specified above.

d.) (Optional.) Enter any additional text in the Text field.

Use this field to create custom text or HTML to display along with the title at the
top of the InQuira Intelligent Search results page.

13.(Optional.) Repeat Steps 11. and 12. for each additional language.
14.Assign an Intent to the Intent Response.

Select an Intent from the drop down Intent Name list. Only Intents that are included
in the Intent Hierarchy are available for selection. You may associate more than one
Intent with the Intent Response, unless the Intent has specified Concept parameters,
and you have specified a Response Concept for the Intent Response.

NOTE:

Only one Intent can be associated with an Intent Response if the Intent has
specified Concept parameters, and a specified a Response Concept for the Intent
Response. For more information see Define Concept Parameters on page 62.

After you select an Intent from drop down list, the Display Name field automatically
completes with the display name of the Intent.

If the Intent you selected has specified Concept parameters, the Parameter Name and
Root Concept fields automatically complete with information from the Intent. If you
are using an Intent with a Root Concept, you may enter the Root Concept or any
children of the Root Concept in the Response Concept field to limit the return of the
Intent Response. A Root Concept is any concept that has associated relationships
where the Concept is the Parent or Grandparent of other Concepts.

NOTE:

The Intent Response does not appear on the InQuira Intelligent Search results page
unless it is assigned to an Intent, and that Intent is included in the Intent Hierarchy.

15.Save the Intent Response.

Select Save from the File menu in the Intent Response window.

54
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NOTE: A new Intent Response does not affect live Intelligent Search results until you
Commit Dictionary Changes to Central Repository (vcroot), and the changes
have been synchronized to the runtime environment, for more information, see
Intelligent Search Administration Guide. To see the effects of new or modified
Intent without committing, use Test Drive.

Kew Intent Response

Cefault Custamer Doman I_

[

i roish |

Title
Link.
Ii'n'ége
Text

Field Description
Name Specify the Response Template name.
Description Enter an optional description of the template. The content of the

Description field is for Dictionary Manager users' reference only.

Notes Enter any optional notes. The content of the Notes field is for
Dictionary Manager users' reference only.

Domain Specify the Domain to which this template belongs. The pull-down
menu displays only domains for which you have permission. For new
templates, the Domain field is set to the domain most recently saved
to.
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Field (Continued) |Description (Continued)

ID Specify an ID for the Response field. The ID must be unique, and
cannot be changed after the parameter is saved.

For example:

The Dictionary Manager automatically populates additional fields
when you specify this field. Select each field to edit its contents.

Display Name Specify the name that the InQuira Language Workbench uses to
display this parameter.

Type Select the type of field from the drop-down menu of supported field
types:

e HTML
e URL
e String

e Boolean
e Decimal

e Integer

Default Value Specify an optional default value for this field, in the appropriate
format for the corresponding data type.

Required... Specify whether this field is optional or required within a formatted
Response.

Intent Response Tools

Before saving an Intent Response, you can verify the function of the Intent Response by
selecting an option from the Tool menu in the Intent Response window. Choose from:

Validate Response on page 57
Reset IM Document Cache on page 57

56 Intelligent Search Language Tuning Guide



Intents, Intent Hierarchies, Intent Responses |NQu|nA,,

Validate Response

After selecting Validate Response from the Tools menu, InQuira Intelligent Search
automatically checks the validity of your Intent Response. If a problem is detected, the
Invalid Value dialog displays explaining the error with the Intent Response

Invalid Yalue

Reszponsze iz Yald

Lid

Reset IM Document Cache

Use Reset IM Document Cache located under the Tools menu to see the latest version of
the IM document referenced in the IM Reference field. Use this option if the IM
document has changed since the Language Workbench last cached the content.
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Create a New Intent in the Intent Hierarchy

58

InQuira Intelligent Search provides Intents that account for the majority of user queries. It
is rare that you need to create a new Intent. However, if there is a need to do so, you can
create a new Intent in order to allow InQuira Intelligent Search to analyze common user
queries phrased differently as having the same meaning, or intent. You can then associate
the Intent to return a specific result, or Intent Response.

In order for an Intent to be used by InQuira Intelligent Search, the Intent must be included
in the Intent Hierarchy. For this reason we recommend creating a new Intent through the
Intent Hierarchy window.

To create a new Intent:

1. In the Dictionary Manager, use the Dictionary Find Tool to open the Intent Hierarchy
to which the new Intent belongs. For information about the Dictionary Find tool, see
Finding Dictionary Objects on page 100. The Intent Hierarchy Window displays:

Customerhelp Intent Hierarchy =] E3

Customerhelp Intent Hierarchy

Intent Library Customerbelp -

Producks This intent Functions as the...
EI@E Product Ordering and 5 & Products
{1} Make Crdet This intent matches on que. ..
{',} Track Crder This intent matches on que. ..
{',} Product Rebates Ir Products This intent matches on que. ..
{',} Warranky Inguiry This intent matches querie, ..
{',} Product Insurance Products This intent matches on que. ..
[—:I---'%E Account Suppork @ This intent matches on que. ..
{',} Update Account Pr This intent matches on que. ..
{',} Close Account This intent matches on que. ..
{',} Account Informatio This intent matches on que. ..
{',} Account Setup Sup This intent matches on que. ..
{',} Account Sign In He This intent matches on que. ..

2. From the displayed Intent Hierarchy, select a parent for the new Intent, and select New
Child.
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NOTE: When selecting the location, keep in mind that InQuira Intelligent Search matches
on the higher level Intents as well through degradation. For this reason, choose a
location for your new Intent that is closely related yet more specific than the
higher-level Intents (parents). The location of the Intent among Intents of the same
level (siblings) does not impact search results.

The Enter New Intent Name window displays.
Enter Hew Intent Hame E3

9_

[ oK ] _cencd |

- Enter a descriptive name for the new Intent and click OK.

IMPORTANT: Confirm that there is no Rule, Intent, or Intent Response in the Dictionary
with the same name.

The New Intent window displays:

Mew Intent

Default Cuskamer Darmain l_

adsHeted oo | [oron o)

|

3. (Optional.) Enter any information regarding the Intent Response in the Notes field.

The Notes field has no impact on InQuira Intelligent Search results. It is used to clarify
the intended function of the Intent Response among users.
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4. Check the Enabled box (default setting). If the Enabled box is not checked, the Intent
Response is ignored by InQuira Intelligent Search.

5. Select the Domain from the drop down list. Only Domains you have permission for are
displayed. The Domain field is set to the most recently saved Domain by default. For
more information see Non-Concept Domains on page 94.

6. Complete the IML Conditions section.

In the space provided, enter the IML expression used to match the variety of words
and phrases that can be used to express a particular user query for information or
assistance. This IML is used to match a question and then trigger the associated
Intent Response.

If you plan to create an Intent that uses Concept Parameters, see Define Concept
Parameters on page 62, then the IML in the Question Pattern must contain a
Global variable. Global variables are place holders with no intrinsic value. Their
value is assigned by the matching process. Global variables are preserved until the
complete search process is complete. Intents can refer to a Global variable created
in the Intent or in a separate Rule or Intent. The value captured by the global
variable is what is passed as a concept parameter to Intent Responses. Global
variables are indicated with a # appearing before the name of the variable.

7. Select the number of matches for the IML expression to find within a given request
from the drop down # Matches list.

This value controls how many times a rule may fire if it matches more than one
part of a query. This is necessary only for more complex rules; for most purposes
this setting is the default.

Default Specifies to process only one match. (is the default setting.)
One Match Specifies to process only one match.

Most Matches  Specifies to process most matches.

All Matches Specifies to process all matches.
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8. Complete the Language-specific Attributes section.To select an additional language,
select from the Add Selected Language drop down list. The Language-specific
Attributes tab displays:

EEm | oo e -

<]

<]

<]

_#dd a question | _fed 3 question |

0o | o CiplayMeme | 0 vasbe

.
9. Enter a name in the Name field.

.

The name typed in the Language tab acts as the display name of the Intent. For
English, it is best practice to copy the name of the Intent specified above. For all
other languages, it is best practice to enter the translation of the name of the Intent
specified above.

10.(Optional.) Fill in the Description field.

The Description field has no impact on InQuira Intelligent Search results. It is used
to clarify the intended function of the Intent among users.

11.(Optional.) Enter Test Questions.

Under the appropriate headings enter questions that you expect to match or not
match based on the IML question pattern specified above. To test each question
individually click the Test button located at the end of the text field. To test all
questions at the same time click the Test Condition button located above. After
selecting Test Condition, the question(s) specified turn blue if it is satisfied
correctly (matching or not matching), and red if it is not. The question appearing as
red indicates that you need to modify your IML question pattern in order to return
the results you expect.

If you want to test additional questions, select Add a Question under either
heading. An additional text field displays.
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Define Concept Parameters

12.(Optional.) Define Concept Parameters.

Concept Parameters enable a single Intent, using the same IML question pattern, to
match a range of questions that differ only in a specific detail, such as a product name.
In order to make use of Concept Parameters the IML question pattern specified above
MUST contain a global variable.

Enter a name for the Concept Parameter in the ID field.

The ID field has no impact on InQuira Intelligent Search results. It is used as a
place holder during the search processes. The ID cannot be changed once the
Intent has been saved.

Enter a name for the Concept Parameter in the Display Name field. (ID name by
default.)

The Display Name completes with the ID name by default. You may choose to
modify the display name, however keep in mind that the Display Name has no
impact on InQuira Intelligent Search results. It is used as a place holder during the
search processes.

Select a VVariable from the drop down list.

In order for Intents to use Concept Parameters the IML Question Pattern specified
above must contain a global variable. The global variable(s) defined in the
guestion pattern above appears as a drop down list in the variable field.

Enter the Root Concept Name associated with the variable.

In order for an Intent Response to trigger based on the Concept Parameters you
must associate both the Concept Parameter and the Intent Response with a Root
Concept. You may type or drag and drop the Root Concept name into the field. .

13.(Optional.) You may add additional languages by repeating Steps 8. 9. 10.11.and 12.
14.Save the Intent.

Select Save from the File menu in the Intent window.

NOTE: A new Intent does not affect live Intelligent Search results until you Commit

Dictionary Changes to Central Repository (vcroot), and the changes have been
synchronized to the runtime environment, for more information, see Intelligent
Search Administration Guide. To see the effects of new or modified Intent
without committing, use Test Drive.
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Intent Scores

You can assign scores to Intents positioned as the highest-level nodes in the Intent
Hierarchy. Each child node inherits the hierarchy score value from its parent. The Rules
Engine applies the hierarchy score so that Intents within more important categories are
preferred to otherwise equally-matched Intents from less important categories and are
displayed first in the search results, above the other equally-matched Intents.

To specify the Hierarchy Score:

__ fntet | Scors | Pavameters | Descripton |

7 all Intents This intent Functions as the parent int. ..
: Product Ordering and Sales Supp Products

@ Account Suppork This intent matches on queries about ...
@ Customer Service Inguiry This inkent matches on queries about .,
@ Billing Inguiry and Support This intent matches on queries about ...
@ General Company Inguiry Your Company M., This inkent matches on queries about .,
@ Website Inguiry This intent matches on queries about ...

e Select the Score column of a top level node from the Intent Hierarchy.

& all Intents

; -[£%] Product Ordering and Sales Supr & Producks
@ Account Suppart 3 This intent matches on queties about ..,
@ Cuskamet Service Inguiry 7 This intent matches on queties about ..,
@ Billing Inquiry and Suppart 9 This intent matches on queries aboutk ...
EE aeneral Campany Inguiry S ¥our Campany M., This inkent matches on queties about .,
] @ WWehsite Inquiry 4 This intent matches on queties about ..,

This inkent Functions as the parent ink. .

Intent Tools

Before saving an Intent you can verify the function of the Intent by selecting an option
from the Tool menu in the Intent Response window. Choose from:

Check IML on page 64
Validate Intent on page 64

w
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Check IML

After selecting Check IML from the Tools menu InQuira Intelligent Search automatically
checks the validity of your IML. If a problem is detected, the IML Syntax Problem
dialog displays explaining the IML error:

IML Syntax Problem

Lid

]

If no problem with the IML is detected, then the IML Syntax Correct dialog displays:

IML Syntax Correct

Lid
—

Validate Intent

After selecting Validate Intent from the Tools menu, InQuira Intelligent Search
automatically checks the validity of your Intent. If a problem is detected, the Invalid
Value dialog displays explaining the error with the Intent

Intent iz Invalid

1\

If the Intent is valid the following Intent is Valid dialog displays.
Intent iz Valid

Lid
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Example of Using an Intent and Creating a New Intent Response

Suppose that after looking at InQuira Analytics we found many user queries for
information regarding purchasing InQuira. To satisfy this query we decide to create a
search result that provides the user with quick and direct access to purchasing
information. To do this we could create a Managed Answer Rule, however we know
that the Intents that were installed with InQuira contain an Intent that already captures
user queries for purchasing information.

Product Ordenng and Sales Support _ | O] x|

Product Ordering and Sales Support
i |
e Lovary Cutomerhely 54

o

DOC{<order>, {<product=
OR ALLCHILDREN({ =<product>))=2#PARAMETER_PRODUCT

)
J=#PRODUCT _ORDERING_AND_SALES_SUPPORT

—

i Soeced Longuage: | [ gy =

Product Ordering and Sales Support
I

Products Products #PARAMETER_PRODUCT  product

Using this Intent, versus a Rule, minimizes our work as the Condition is already
established using IML. Instead, we only need to create the Action. To do this we must
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create a new Intent Response. From Workbench we select Create a new Intent
Response. We name the Intent Response and add any additional information as explained
above.

Purchase InQuira

Purchase InQuira

provide link to Purchasing Information Manager

ETET T

We then complete the Response fields as described above.

Learn more about puchasing Informati. .. Edit
hitkp: /sy, inguira, com

After entering this information, the last step is to assign the Intent to the Intent Response.
From the Intent Name column, select an Intent from the drop down menu.

Product Ordering and Sales 5... Product Ordering and ... Products produck information

In this example, we select the Product Ordering and Sales Support Intent that has a Root
Concept associated with it. To utilize this feature we must enter a Response Concept,
which must be a child of the Root Concept <products>. We select the Concept
<information manager> which we have made a child of <products> by establishing a “is a
type of” relationship.

After saving the Intent Response, we expect any time a user queries for information
regarding ordering information manager the Intent triggers and the Intent Response
displays on the search results page.
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We check the results using Test Drive.

||:|r|:|er InQuira products | Find
Example;"Does Product-¥ have Feature-v?" Tips
tTypes: Answers A
re we
[TML (1 .
[TML (1) answering
Learn rare about puchasing InQuira your
lections: Inuira products include Intelligent Search, Infarmation questions?
nuira Manager, and InQuira Analytics!
mnalytics O ghsolutely!
nstallation (1) (] Usually
InQuira Analytics Beguirements and O E s
Dependencies O Hard|
InQuira Analytics Requirements and Dependencies The o Y
InQuira Analytics environment reguires an installed
and configured InQuira 8.0 application. See the InQuira Mot even close!

8.0 documentation as described in InQuira Product
Docurnentation for information on installing, configuring
and deploying an InQuira 3.0 application.

Submit

Back < Pagel > MextPage

|NQE"|"'F?A..

As expected, the first answer returned is the result of the newly created Intent Response.

Adding an additional language Intent Response

Continuing to use the Product Order and Sales Support Intent above we create an Intent
Response that displays on a Chinese-based search results page.

Using the Purchase InQuira Intent Response created above, select Chinese from the drop
down menu and select Add Selected Language. An additional response tab displays:

* Title
* Link,
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In the title field we enter the Chinese equivalent to “learn more about purchasing
Information Manager” and a link to the associated website.

(EEERAITE¥E

hitkp: v inquira, cn

After saving, we check the results using Test Drive, making sure the Language is set to
Chinese. The following results display:

% EAEER =i

HiEan

v B S Tl s X RS ESThEE v

JocTypes: =a .

15818 7 i Rt ;
InQuira iz 818 AR - HEEE S01E L HIER G BRET -EX O e

Zollections:
e way % T TiEmiEe s d 4k, Kt S RILE M. TS5 it mE )
Chinese (1) FABE 83, {82 RE5 5 it B i 5 . LU 4 2o Sopon 1% A B
18, &IEILEHE P FE RS RS da AT B ER], BT
O Tif=
B . O sk |
EEEHER

FAEER

e o« k1 -~ F-T
As expected the InQuira Intelligent Search results page displays the Intent Response.
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Rules

Rules are Dictionary objects that determine how InQuira Intelligent Search interprets and
responds to user queries. Rules correspond to if/then statements, so that, if the specified
Conditions are satisfied, then the specified Action occurs. Rules are used by the Rules
Engine to determine the response criteria for a user query and to narrow search results
based on user context and your company’s content.

Creating Rules in Dictionary Manager allows InQuira Intelligent Search to:

e Return the best possible answers by establishing precedence and scoring criteria.
e Return Managed Answers to satisfy users request and your company’s needs.

e Restrict returned results based on set conditions and content.

There are various types of Rules that can differ in terms of intricacies. This section focuses
on basic Managed Answers and basic Search Component Rules using a specialized
language designed by InQuira to identify language patterns. The InQuira Matching
Language, IML, is a proprietary language that is similar to regular expression languages in
its logic. It is used capture the variations in written language that can be used to express
requests. For more information, see Intelligent Search Language Reference.

Another language used in Rules is one that allows the manipulation of strings. The
Variable Instantiation Language, or VIL, is designed as a series of replacement operations
where a particular string captured in the statement may get, for example, uppercase,
lowercase, or replaced by a corresponding string in a list. For more information see
Intelligent Search Language Reference.

For information on the features of Rules listed on the Advanced menu, please see
Intelligent Search Optimization Guide.
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Create a New Rule- Managed Answer Rule (default Custom Content)

70

By creating new Rules, you allow InQuira Intelligent Search to restrict what kind of
results are returned based on set conditions and corresponding actions. Managed Answers,
also referred to as Best Answers or Custom Content Rules, are used to return a specific
answer for a specific set of query types. They are used typically to supplement missing
content, for example if your company is lacking documents that accurately answer a type
of query, or as a way to ensure business critical content displays in addition to regularly
displayed search results. Managed Answers operate independent of regular search, and
once triggered, are returned regardless of the other results returned by InQuira Intelligent
Search. Managed Answers usually appear as the first returned result on the search results
page, or they can be designated to appear in a particular portlet.

To create a new Managed Answer Rule:

1. In Dictionary Manager, select the *] icon or New Rule from the File menu.
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The Rule window displays with the default Action as Custom Content:
S Mew Rule

Default Customer Damain

oefak__ =

Zuskom Conkent |_

2) Name the Rule.

It is best practice to name rules in a consistent manner. We recommend starting all
Managed Answers with BA, for best answer, or MA for managed answer.

2. Fill in the Description field. (Optional.)

The Description field has no impact on InQuira Intelligent Search results. It is used to
clarify the intended function of the Rule among users.

3. Enter any information regarding the Rule in the Notes field. (Optional).

The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on Rule modifications among users.

4. Check the Enabled box. (This is selected by default.) If the Enabled box is not
checked, InQuira Intelligent Search ignores the Rule.

5. Select the Domain from the drop down list. Only Domains you have permissions for
display. The Domain field is set to the most recently saved Domain by default. Set the
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Domain to your company Domain or to the “Default Customer Domain.” For more
information on Domains, see the following section Domains and Domain Lists on
page 94.

6. Complete the Conditions section.

Thinking of Rules as if/then statements, the information provided under the Condition
section corresponds with the “if” portion. By default, the Question Patterns Tab
displays. Other tabs: Business Conditions and Deferred Conditions can be added by
selecting from the Advanced menu. These options are discussed in Intelligent Search
Optimization Guide.

- Under Question Patterns, enter the IML expression used to match the variety of
words and phrases that can be used to express a particular user query for
information or assistance. This IML is used to match a question and then trigger
the Actions defined below. Parts of the IML expression entered in the question
pattern display as various colors if entered correctly. For more information see
Finding Dictionary Objects on page 100.

The simplest question pattern you can enter is a string in double quotes. for
example, by entering “cat” in the Question Pattern, any time a query contains the
word cat (though not cats) the Managed Answer Rule fires, and the custom content
appears at the top of the search results page. You can create more complicated
Question Patterns using IML, as explained in the Intelligent Search Language
Reference.
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Select the number of matches for the IML expression to find within a given request
from the drop down menu.

This value controls how many times a rule may fire if it matches more than one
part of a query. This is necessary only for more complex rules; for most purposes
this setting is the default.

Default Specifies to process only one match. (Default)

One Match Specifies to process only one match.

Most Matches  Specifies to process most matches, not including overlapping.
All Matches Specifies to process all matches.

7. Complete the Actions section. Thinking of Rules as if/then statements, the information
provided under the Action section corresponds with the ‘then’ portion. By default, the
Answer: Custom Content tab displays. The Answer tab varies in relation to the
method selected from the drop down menu. The simplest Managed Answer to create is
using the Custom Content method, and the following steps correspond to this method.
For more information on Answer Action Methods, please see Intelligent Search
Optimization Guide.

Select a Purpose from the drop down menu.

A purpose, also referred to as a portlet, corresponds to display characteristics
defined in the User Interface, enabling you to establish consistent, focused and
targeted presentation for various types of content. For specific information on
purposes, see Purpose (portlet) on page 158:

Select a Priority from the drop down menu.

The Priority specifies the ranking of Managed Answers, in particular when
multiple Managed Answer rules are returned based on the same criteria. Choose
from:

Highest  Displays this Managed Answer first, assuming all criteria for the
following Managed Answer are the same.(Default.)

High Displays this Managed Answer second, assuming all criteria for the
following Managed answers are the same.

Medium Displays this Managed Answer third, assuming all criteria for the
following Managed answers are the same.

Low Displays this Managed Answer fourth, assuming all criteria for the
following Managed answers are the same.

Lowest  Displays this Managed Answer fifth, assuming all criteria for the
following Managed answers are the same.
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- Select a Method from the drop down menu.

The Method specifies how InQuira Intelligent Search executes a specified action.
Choose from:

Custom Content  Creates a response using custom content, including text, title,
and link. (Default.)

Specific Excerpt  Creates a response using a specified excerpt.

Search Launches a search in the indexed unstructured content.

Structured Query Launches a search against a structured data source.

Glossary Creates a response from the glossary entry associated with the
specified term.

Plug-In Creates a response using an external method, based on

configured plug-in code.
Process Wizard  Creates a response using a specified custom process wizard.

NOTE: To create the simplest Managed Answer, select the Custom Content method and
follow the directions below.

- Enter aftitle in the Title field and a URL in the URL field. (Optional, or use the
Custom Content field described below.)

Type the title as you want it to display as hypertext on the InQuira Intelligent
Search results page.

Type the full URL link associated with the hypertext title specified above.
- Enter HTML or plain text in the Custom Content field.

Use this field to create custom text or HTML to display at the top of the InQuira
Intelligent Search results page.
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8. Save the Rule.

Select Save from the File menu in the Rule window. If your Rule contains an invalid
format, the following Problem Saving dialog displays:

Ni Problem Saving

If this error displays and you are unsure of the problem select a test from the Tools menu,
see below in Rule Tools on page 83.

For information on options under the Advanced menu of the Rule window, please see
Intelligent Search Optimization Guide.

NOTE: A new Rule does not affect live Intelligent Search results until you Commit
Dictionary Changes to Central Repository (vcroot) on page 103, and the changes
have been synchronized to the production environment, for more information see
Intelligent Search Administration Guide. To see the effects of new or modified
Rules without committing, use Test Drive.
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Create a New Rule- Search Component Rule

76

By creating new Rules, you direct InQuira Intelligent Search to restrict which results are
returned based on set conditions and corresponding actions. Search Component Rules are
the primary method of specifying information retrieval for both unstructured and
structured data. Search Component Rules are used to define search criteria based on
matching some portion, or range, of a user query using IML or SQL expressions.

Search Component Rules affect the search results by adding weight to the matches they
specify. InQuira determines which documents to provide as the best answers to a user
query by assigning a score to a document if it matches the search components that are
created from the query. The search components are obtained by, for example, synonyms
of the word or phrase that is being searched on, or its clusetermates. Each match between
these search components and documents is associated with some numeric score, and each
match contributes to the overall score the document receives. Once these scores are tallied,
the documents are ranked accordingly, and the highest ranking document is returned as the
best match.

Creating a Search Component Rule allows us to assign additional points to matching
documents, thus boosting the overall ranking of the document. For this reason, Search
Component Rules, are an effective way to tune your dictionary and maintain the best
InQuira Intelligent Search results.
1. In Dictionary Manager, select the =% icon or New Rule from the File menu.

The Rule window displays with the default Action as Custom Content.
2. Replace the Answer Action tab with a Search Component Tab.
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- Delete the Answer: Custom Content tab by selecting the & icon. The really
delete? dialog displays, select yes. The following window displays with no
Actions tab:

=N New Rule

I
I
|

Default Customer Domain Ea

oot o]
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- Under the Advanced menu, select Add Search Component. A Search
Component Tab appears in the Rule window:

C:) New Rule

Default Customer Domain -

Name the Rule.

It is best practice to name rules in a consistent manner. We recommend starting all
Search Component Rules with SC, for search component.

(Optional.) Fill in the Description field.

The Description field has no impact on InQuira Intelligent Search results. It is used to
clarify the intended function of the Rule among users.

(Optional.) Enter any information regarding the Rule in the Notes field.

The Notes field has no impact on InQuira Intelligent Search results. It is used to track
comments on Rule modification among users.

Check the Enabled box. (This is selected by default.) If the Enabled box is not
checked, InQuira Intelligent Search ignores the Rule.
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Select the Domain from the drop down list. Only Domains you have permissions for
display. The Domain field is set to the most recently saved Domain by default. For
more information on Domains see the following section Domains and Domain Lists
on page 94.

Complete the Conditions section.

If we think of Rules as if/then statements, the information provided under the
Condition section corresponds with the ‘“if” portion. By default, the Question Patterns
Tab displays. The other tabs: Business Conditions and Deferred Conditions can be
added by selecting Advanced and are discussed in Intelligent Search Optimization
Guide.

Under Question Patterns, in the space provided, enter the IML expression used to
match the variety of words and phrases that can be used to express a particular user
query for information or assistance. This IML is used to match a question and then
trigger the Action defined below. Parts of the IML expression entered in the
question pattern display as various colors if entered correctly. For more
information on the color code please see IML Color Code on page 159.

Search Component Rules must contain a variable. Variables are place holders with
no intrinsic value. Their value is assigned by the matching process. For example, if
the IML statements assigns the string that matches the concept <information
manager> to the variable A (<information manager> =A), if the Concept is
matched to the string “information manager: the value assigned to A is
“information manager”. If the Concept is matched to “IM” then the value assigned
to A is “IM.” Capturing strings in this was can be very useful. For instance, you
may choose to search for the exact string in the documents. Or you may want to
tell the user that their search for “IM” or “information manager” retrieved no
results. The language that allows us to manipulate the values assigned to a variable
is called the Variable Instantiation Language, or VIL. VIL is discussed in
Intelligent Search Language Reference.

There are two types of variables: Local and Global. Local variables are created
within a Rule and disappear as soon as the Rule completes its action. Local
variables are any letter or word that has been assigned a value through the
assignment operator, X. It is common practice to use a set the variable equal to a
capital letter. By contrast, Global variables are preserved until the entire search
process is complete. Rules can refer to a Global variable created in another Rule.
Global variables are indicated with a # appearing before the capital letter used to
define the variable.

The simplest question pattern you can create is using a string in double quotes set
equal to a variable. for example, cat=A, whereas any time a query contains the
word cat (though not cats) the Search Component Rule fires, and the action
associated with the variable A receives a value,. Once the condition is satisfied and
the rule is fired, the Action portion of the rule is activated. You can create more

Intelligent Search Language Tuning Guide 79



INQUIRAM

Rules

complicated Question Patterns by understanding IML as explained in the
Intelligent Search Language Reference.

Select the number of matches for the IML expression to find within a given request
from the drop down menu.

This value controls how many times a rule may fire if the question pattern matches
more than one part of a query. This is necessary only for more complex rules; for
most purposes this setting is the default.

Default Specifies to process only one match. (Default.)
One Match Specifies to process only one match.

Most Matches Specifies to process most matches.

All Matches Specifies to process all matches.

e Complete the Actions section. Thinking of Rules as if/then statements, the information
provided under the Actions section corresponds with the “then’ portion.Select the
Search Component tab as described above. The Search Component tab varies in
relation to the Importance level selected from the drop down menu.

Enter a variable.

In the Question Pattern above, you set an IML statement equal to a variable
(usually A). In the Variable field enter this variable.

Select a level of importance from the Importance drop down menu.

The Importance setting specifies the score value range of the Search Component
Rule. The range you select here affects the values assigned to matches in the IML/
SQL field below. Choose the Importance level from:

Required Range descends from 100,000 scoring points.

Very Important Range descends from 10,000 scoring points.
Important Range descends from 1,000 scoring points. (Default.)
Minor Range descends from 100 scoring points.

Trivial Range descends from 10 scoring points.

NOTE:

It is best practice to set the Importance level to Trivial, and then raising the level
until the desired effects in the ranking of the search results are obtained.

80

Select a search type and search subtype from the drop down menus.
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First choose a search type from:

Index  Use this search type to define criteria using IML expressions
for searching the unstructured content indexes in the Content
Store (Default).

SQL Use this search type to define criteria using SQL queries for
retrieving information form configured structured data
sources.

In most cases, you select Index, intended for natural language search against
indexed documents. After you have selected the search type, choose a search
subtype from the drop down menu. Your choices vary depending on which Search
type you choose.

If you choose Index as your search type, the Rules Engine uses the subtype value
to order the assigned Search Components within the action list. Choose the
subtype from the following:

ranking Used by the Rules Engine to order the ranking subtypes
after the standard subtypes within the action list.

standard Used by the Rules Engine to order the standard subtypes
first within the action list. (Default.)

unspecified Used to prevent the Rules Engine from ordering unspecified
subtypes.

If you choose SQL as your search type, the Rules Engine uses the subtype value to
populate the SQL statement that it generates to query the data source. Choose the
subtype from the following:

econdition
ofield
ebinary operator
etable
eorder
elimit
eunspecified
-Select a Purpose from the drop down list.This is typically set to Answer.

Purposes, or portlets, correspond to display characteristics defined in the User
Interface, enabling you to establish consistent, focused and targeted presentation
for various types of content. For more information, see Purpose (portlet) on
page 158.
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- Enter IML/SQL statement(s).

Use the IML/SQL field to enter multiple IML, VIL, or SQL statements that
InQuira Intelligent Search uses to ensure the best possible answers to a user query.
Enter the statements in order of priority. Intelligent Search uses this order with the
Search Component Rule to specify a set of prioritized search instructions in
response to matching the Question Pattern described above. The scoring values
assigned to the IML/SQL statements correspond to the Importance level set above.
The first level indicates the preferred contents to display on the search results page.

- You can enter as intricate statement as desired by using IML, VIL, and SQL. For
more information on creating IML or VIL statements see Intelligent Search
Language Reference. The IML and/or VIL entered in this section displays as
various colors if entered correctly. For more information on the color code please
see IML Color Code on page 159.

e (Optional.) Set Supplement and Subsume.

Select Supplement/subsume from the Advanced menu in the Rule window. The
Supplement and Subsume boxes appear in the Search Component tab.

- Check the Supplement box if you want the Rule to work in addition to other
Search Component Rules triggered by the same portion of the user query. This is
selected by default. If the box is unchecked, the Search Component Rule stops
other Search Component Rules from matching, making them ineffective in the
scoring process.

- Check the Subsume box if you want to ignore other Search Component Rules
triggered within the same portion of the user query as the current Rule. This is
cleared by default. If cleared, multiple Search Components may fire covering the
same portions of the user query.

e Save the Rule.

Select Save from the File menu in the Rule window. If your rule contains an invalid
format the following Problem Saving dialog displays:

Ei Problem Saving
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If this error displays and you are unsure of the problem, select a test from the Tools menu,
see Rule Tools on page 83.

For information on options under the Advanced menu of the Rule window, please see
Intelligent Search Optimization Guide.

NOTE: A new Rule does not affect live Intelligent Search results until you Commit
Dictionary Changes to Central Repository (vcroot), and the changes have
been synchronized to the runtime environment, for more information see
Intelligent Search Administration Guide. To see the effects of new or modified
Rules without committing, use Test Drive.

Rule Tools

Before saving a newly created Rule, you can verify the function of the Rule by selecting
an option from the Tool menu in the Rule window. Choose from: Match Against a
Question, Check IML, or Validate Rule.

Match Against a Question

After selecting Match Against a Question from the Tools menu the Match Rule Name
Against a Question box displays:
2 Match BA Information Manager against a question _ O] x|

|

s EEn EhEE BN ES

e Enter a query that you expect your newly created Rule to satisfy in the Question field.
e Select Test.

Upon testing the query, the Match Against a Question Results field displays one of the
following messages:
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- The Question did not match the Question Patterns.
- The Question successfully matched the Question Patterns.

If the query matches successfully the following displays:
Z Match BA Information Manager against a question _ | O] x|

ST

e Select Show Instantiated Rules to see the Rule.

Check IML

After selecting Check IML from the Tools menu InQuira Intelligent Search automatically
checks the validity of your IML. If a problem is detected, the IML Syntax Problem
dialog displays explaining the IML error:

IML Syntax Problem

Lid
-

If no problem with the IML is detected, then the IML Syntax Correct dialog displays:

IML Syntax Comect

Lid

R
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Validate Rule

After selecting Validate Rule from the Tools menu InQuira Intelligent Search
automatically checks the validity of your rule. If a problem is detected, the Rule is Invalid
dialog displays explaining the error with the Rule

Rule iz Invahd

1\

If the Rule is valid the following Rule is Valid dialog displays.
Rule iz Yalid

LiJ

Example of Creating a Managed Answer

Based on the InQuira business context ,we know that many users query for “install IM’. It
is for this reason we create a Managed Answer to quickly and easily return the desired
information to the user.

From Workbench, select create a new Rule. Name the rule and add any additional
information, as explained above.

EDBJ& Information Manager

BA Information Manager

e

Should return link when user gueries install IM or Install information
anager

Base Concept Appearance TITLE

Next define the Question Pattern. We know that we want the Managed Answer to be
returned anytime a user queries ‘Install IM’. We could enter a simple string; however, it is
best to enter a more general pattern expressed in IML using the Concepts in order to
capture the language variants of both install and IM that a user may query, such as ‘Set up
Information Manager’. To do this, drag and drop both Concepts <verb.change.set up>and
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<noun.inquira.information_manager> into the Question Pattern field. This IML requires
the user query to contain two words: one a defined synonym to the Concept <set up> and
the other a defined synonym to the Concept <information manager>.

DOC{<set up>, <information managerz)

After you have established the Question Pattern, define the actions as explained above.
For this example, we assume that any time a user queries for information on installing

Information Manager we want to provide them with a link to the Information Manager
installation document.

rsver o] et oo oreere.
T

Get instructions on how to install Information Manager
bt tp: ffdocurnentation. inguira, com

InCuira Information Manager is a

content managernent systerm that provides a
cormplete, workflow-driven content autharing, editing, review, and publishing environment to

support the entive information lifecycle. It is a separate module that integrates easily with existing

InQuira applications to organize and share any type of enterprise information arnong contact
center agents, partners, and custormers, |
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Save your Managed Answer and check the effect in Test Drive. The following results are

returned:

Types:
ML (106}

lections:

1 Install 73
ocs (45)

1 Install

ocs (48]
1Lira

nalytics
istallation (137

install im

Example:"Does Product-» have Feature-rs"

Answers

Get instructions on how to install Information
Manager

InQuira Information Manager is a full-featured content
management systemn that provides a complete,
warkflow-driven content authoring, editing, review, and
publishing environment to support the entire
information lifecycle. It is a separate module that
inteqrates easily with existing InQuira applications to
organize and share any type of enterprise information

arnong contact center agents, partners, and custormers,

The Information Manager Product Distribution
The Information Manager Product Distribution
Information Manager for Microsoft Windows
install_im.exe Information Manager for Sun Solaris

Starting the Installation Program

Starting the Installation Program execute
install_im .exe

Ahout the InQuira Analytics Installation Guide

In This Guide This section describes the general
installation process, lists hardware and software
requirermnents and dependencies, and provides product
packaging and distribution information, This section

Are we

answerir
your
question

C Somet

O Hardly
O

Mot even

_

As expected, the first answer returned is the result of the newly created Managed Answer.

Example of Creating a Search Component Booster Rule

Booster Rules are Search Components or other Search Rules that boost content from
Certain facets, documents, or types of documents.

It is best to reserve Booster Rules for very specific situations where, all else being equal,
answers from certain parts of the content be returned before answers from other parts of
the content. Otherwise, Booster Rules can cause strange responses or no responses to

some queries. See Booster Rules Issue on page 89.
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Types of Booster Rules

The form of a Booster Rule depends on the type of content that needs boosting. The
following examples present general guidelines for various types of booster rules. They can
all be modified to adapt to specific business needs.

Boosting a Facet
Use or modify the following to boost a facet.

Question Pattern

If there is no restriction on the type of question, InQuira recommends that you consider
stating a fairly general restriction such as:

(BEGIN (( *) (#VerylmportantConcept OR #RequiredConcept) ( * ))=A END)

Action

Search Component. Variable: A. Recommended settings: Try Importance = trivial
first, and raise only as needed; Check Supplement, uncheck Subsume. If
"Classification.MyFacet" is the facet you'd like to boost, this suffices:

FACET(("Classification.MyFacet")

If you need to boost several facets, but not equally, you can write multiple booster rules
with varying Importance.

Boosting a Document or Document Type
Use or modify the following to boost a document or document type.

Question Pattern

If there is no restriction on the type of question, InQuira recommends that you consider
stating a fairly general restriction such as:

(BEGIN (( *) (#VerylmportantConcept OR #RequiredConcept) ( * ))=A END)

Action

Search Component. Variable: A. Recommended settings: as above. If you can find a
language characteristic X common to the documents of the desired type, you can write:

DOC(X)
where X can be something like
NEAR_6(("tutorial™ OR "guide"),"revised")
or
TITLE("tutorial™ OR "guide")
Use Service Browser to determine the best way to express X.
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Boosting Documents with a Particular Version or Kind of a Product
When a user asks about a product without specifying a version (or other attribute, such as

year), the customer wants answers to be returned first that are about a certain version or
attribute (such as current year).

Suppose the preferred year is 2005. Assume also you have defined global variables for
#modelYear to recognize years and #model to recognize the products or models in
question.

Question Pattern

DOC(BEGIN ( * )=A #model=B ( * )=C END) ISNT DOC(#modelYear)
Action
Plugin=Restart Question. New question:

A->NOVAR(ACTION="")->STRING(NODUPS="false")} {B.EN} 2005 {C-
>NOVAR(ACTION="")->STRING(NODUPS="false")

Booster Rules Issue

Before you create booster rules, you should be aware that Booster Rules may cause
questions with no matches to suddenly start returning bad answers. For example, an off-
the-wall question such as "Superman?" starts returning answers after the Booster Rule was
introduced.

What is happening is that the query satisfies the Booster Rule question pattern, and some
content gets enough of a score—thru the boost—to qualify as an answer.

Solutions:

e Restrict the question pattern to avoid matching to questions that don't belong. For
example, you can try excluding unknown words or string literals from satisfying the
question pattern. Modify the question pattern to:

(BEGIN (( *) (#VerylmportantConcept OR #RequiredConcept) ( * ))=A END)
ISNT (#UnknownWord(1-) OR ("\"" +"\"")).

e Another cause may be unimportant medium level concepts that still satisfy the
question pattern. If possible, change the level of these concepts to "low". If there many
such concepts, it is probably faster to export them, use Excel to change their scores to
10, and then reimport them.

e Raise the minimum score for the Portlet, usually Answers. Go to Admin Tool,
Dictionary Service > Answer Purpose > Answer Purpose. By default the minimum
score is set to 0.0. Raise it just enough to offset the booster rule, probably to 0.2 or 0.3.

Example

InQuira has three major products: Intelligent Search, Information Manager, and Analytics.
As these components are configured to work together, the documentation for each product
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contains references to the other products. For example, a search on “install im” returns the

following results.

install im

Exarmple:"Does Product-» have Feature-y:"

DocTypes:
b HTML (106

Collections:
¢ IM Install 73
Ciocs (45}
¢ IM Install

Diocs (48]
¢ InQuira

Analytics
Installation (13)

Answers

et instructions on how to install Information
Manager

InQuira Information Manager is a full-featured content
rianaderment systern that provides a complete,
waorkflow-driven content authaoring, editing, review, and
publishing environment to support the entire
inforrmation lifecycle, It is a separate module that
integrates easily with existing InQuira applications to
organize and share any type of enterprise information

arnong contact center agents, partners, and customers,

The Information Manager Product Distribution

The Information Manager Product Distribution
Inforrmation Manager for Microsoft Windows
install_im.exe Information Manager for Sun Solaris

Starting the Installation Program

Starting the Installation Program execute
install_im.exe

About the InQuira Analytics Installation Guide

In This Guide This section describes the general
installation process, lists hardware and software
requirements and dependencies, and provides product
packaging and distribution information, This section

Are we
answerir
your
question

) ahsol
' Usuall
' Somet

O Hardly
O

Mot even

NOTE: The fourth result is from the InQuira Analytics Installation Guide.

Knowing the InQuira business context, we can safely assume that if a user query contains
the words “install” and “im”, the user would benefit from the Information Manager
documentation set rather than, for example, the Analytics documentation set. In order to
prefer the Information Manager documentation set over the other sets we create a Search

Component Rule.

90
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To create the new Search Component Rule:

From Workbench, we select create a new Rule. As described above we delete the default
action tab. We replace it with a Search Component action by selecting Add Search

Component from the Advanced menu of the Rule window. The Rule window now looks
like the following:

% New Rule

Default Customer Domain 2

E
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We name the Rule following conventional naming practices.
5 SC IM Booster Rule ™ =] B3

SC IM Booster Rule

Finosts the IM Installation Guide over ather quides that conkain information related to installing
ige

Base Standard -

Using IML we create a question pattern that causes the Rule to fire anytime a user queries
about “installing IM”.

ootk ]|

DOC{<set up>, <information manager:J=A

After we have established the Question Pattern we define the actions as explained above.
First we set the Importance level to Trivial, keeping in mind that after checking the Rule in
Test Drive we may need adjust this setting to obtain the desired results.We use IML in
order to prefer the Information Manager Installation Guide over the other documentation
sets. The action appears as:

TITLE ("Information Manager Installation Guide")

Currently, this action states that when the question pattern above is satisfied, assign an
additional 10 points to documents that contain the title Information Manager Installation
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Guide, which, effectively, is the title for the complete Information Manager Installation
documentation set. We then save our Search Component Rule and check the effect in Test
Drive. The following results are returned.

install im
& = Example:"Does Product-% have Feature-ve"
1
DocTypes: ANSWErs A
re we
b HTML (106) ‘
answeriy
_-.I . . . . your
Collections: Zet instructions on how to install Information question
b IM Install 73 Manager o
Docs (45) InQuira Information Manager is a full-featured content Absol
k IM Install rmanagernent systemn that provides a complete, 2 Usuall
Diocs (48) warlkflow-driven content authoring, editing, review, and 's
v InQui blishi i tt rt the enti some
nouira publishing environment to suppo e entire
Analytics information lifecycle, It is a separate module that 8 Hardly
Installation (13} integrates easily with existing InJuira applications to O

organize and share any type of enterprise information

among contact center agents, partners, and customers, Mot even

about the Information Manager Installation
Guide

In This Guide This section describes the general
installation process, lists hardware and software
requirermnents and dependencies, and provides product
packaging and distribution information. This section
describes how to use the packaged installation
program to install and configure the Information
Manager software,

About the Information Manager Installation
GuUide

about the Information Manager Installation Guide This
quide is intended far technical staff who are
responsible for installing InQuira Information
Manager. It provides detailed information on installing j

As shown in the Test Drive results, the first response is the Managed Answer created
earlier, followed by documents that include the title “Information Manager Installation
Guide.” Since the Search Component Rule is effectively altering the search results, there
is no need to adjust the Importance level from Trivial.
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Domains and Domain Lists

Each Dictionary Object in the Dictionary is associated with a Domain.
There are two types of Domains:

e Concept Domains on page 94

e Non-Concept Domains on page 94

Each Domain is associated with Domain Lists on page 97.

Concept Domains

Concept and Cluster information within the Dictionary is stored in a special repository
called the Ontology. The Ontology is organized into Concept Domains that reflect areas of
conceptual knowledge relevant to a discrete area, such as:

e Base language, for example English

e Industry or subject matter area

e Specific company or application

The default Concept Domain is Base Concepts.

Non-Concept Domains

94

Non-Concept Domains are collections of Dictionary Objects other than Concepts and
Clusters that address specific areas of knowledge required by InQuira Intelligent Search.
Domains range in scope from general to specific. The most general Domains contain
extensive vocabulary for native languages, these are referred to as Base Domains. More
specific Domains address various industries and are therefore referred to as Industry
Domains. These two Domain types are installed with InQuira Intelligent Search. The most
specific Domains are Customer Domains, which address the unique characteristic of your
company’s business environment and business needs.

The default Domain is set in the Advanced Configuration File, for more information see
Intelligent Search Administration Guide.
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Create a new Domain

To create Domains:

1. In Dictionary Manager, select Edit Domains from the Tools menu.
The Edit Domains window displays:

Edit Domains

2. Enter a descriptive name into the Non-Concept Domains field or the Concept
Domains field of the Edit Domains window,
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3. Click Add. The Save new dialog displays:

Save new?

4. Click Yes. The Domain is now created and may be used immediately.

Your newly created Domain is automatically included in the English Customerhelp
Domain List. To modify which Domain List a Domain belongs to, see Domain Lists on
page 97.

Delete a Domain

To delete a Domain:

1. In Dictionary Manager, select Edit Domains from the Tools menu.
The Edit Domains window displays.

2. Select the [ box next to the Domain you want to delete from the Edit Domains
window.

NOTE: You may not delete a Domain that is included in a Domain List. The Can’t Delete
Domain error displays:

96

Can't Delete Domain

1\

Intelligent Search Language Tuning Guide



Domains and Domain Lists

Domain Lists

INQUIRA.,

Domains are organized into collections called Domain Lists. Each query is submitted with
an instruction that identifies the Domain List to which it applies. The default is the English
Customerhelp. As a part of the InQuira implementation process, Domain Lists have been
established for you.

Create a new Domain List

NOTE: Domain Lists have been created for you as a part your company’s custom InQuira
configuration.

To create a new Domain List;

1. In Dictionary Manager, select Edit Domain Lists from the Tools menu. The following

Domain Lists window displays:

4 Domain Lists

&

English &ppliances

Enadlish

‘;" Enalish Autormative Enalish
Q} English Boolean Enalish
Q} English Computer Enalish
Q} English Customerhelp Enalish
Q} Enalish Finance Enalish
Q} Enalish Medical Enalish
Q} Enalish Medical HMO Enalish
Q} English Telecom Enalish
<_»[English Utilities English
Q} French Automotive French
Q} French Boolean French
Q} French Customerhelp French
Q} French Finance French
Q} French Telecom French
Q} German Automotive GErman
Q} German Boolean Erman
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2. Click Add new Domain List. The Domain List window displays.

Domain List

R

3. Enter a name for your new Domain List in the Name field.

4. (Optional.) Enter a description of the Domain List in the Notes field.
5. Select a Language from the drop down list.
6. Select Dictionary Domains to include in the newly created Domain Lists.

NOTE: You must order the Domains from most general to most specific

98

Drag Dictionary Domain names from the Excluded Domains column on the left side
to the Included Domains column on the right side.

After a Domain List has been created, you can modify which Domains it includes by
selecting the Domain List name from the Domain Lists window and dragging and
dropping the Domain names from the Excluded list to the Included list and vice-a-versa.
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NOTE: We recommend that you do not modify the English Customerhelp Domain List.

Active Domain List

The Active Domain List is used during a context dependent task, for example, match
against a question, test intent conditions, validate IML. The Active Domain List restricts
which Domain List to use when performing these tasks.

The default Active Domain List is English Customerhelp.
To change the Active Domain List:

e Select the Active Domain List from the drop down menu located in the upper right
hand corner of Dictionary Manager.
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Finding Dictionary Objects

The Dictionary Find Tool allows you to search using set criteria in order to locate a
Dictionary Object with ease.

Upon first opening Dictionary Manager, the Dictionary Find Tool window displays:
i Dictionary Find Tool

You can also access the Dictionary Find Tool by selecting Edit > Find Dictionary Objects
or by selecting the E icon.

In order to limit the amount of Dictionary Objects returned by the Dictionary Find Tool
you can specify search criteria. You can use the Search Criteria Operators on page 160.
You can specify general search criteria to search for all types of objects, or specify
definition-specific criteria to search for a single type of object.

To specify search criteria for all types of objects, select the All Types radio button. The
General search criteria fields display, as described in Specifying General Criteria on
page 161.

To specify search criteria for a specific type of object select the corresponding radio
button. The General search criteria fields display as well as the search fields for the
selected type display, as described in:

e Specifying Concept-Specific Criteria on page 162

e Specifying Rule-Specific Criteria on page 163

e Specifying Intent or Intent Hierarchy-Specific Criteria on page 163
e Specifying Intent Response-Specific Criteria on page 164
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For more information on finding Dictionary Objects not discussed in relation to language
tuning please see Intelligent Search Optimization Guide.

Displaying Dictionary Search Results

The Find Objects Results window displays the objects that match the search criteria:

Enabled/Disabled
Status

Object Type

¢,3 Account Setup Suppoart internaliInduira Feb 7 '08 10:244M Inktent Library Telecom

* | s (D.:' Bank of America internall Administratar Mar 5'03 11:26AM Finance Concepts
(D.:' cellular telephone internaliInduira Feb & '08 11:004M Base Concepks
(D.:' IML Account Setup internaliInduira Feb 7 '03 4:47PM  Base Concepks
- (D.:' information manager internall Administratar Feb 14 '03 4:158PM Base Concepks
- ke | aunich Docurnent Search internall Administratar Feb 19'03 11:348MEase Standard
[ | [®mirute |internaliInQuira Feb 2 '08 11:098M |[Base Concepts
+ |2&| new Inkent Response internall Administrator Mar ¢ '03 2:57PM  Default Customer Domain
(D.:' ring kone internaliInduira Feb & '03 1:45PM  Telecom Concepks
(D.:' w0 ar circuit internaliInduira Feb 6 '08 9:414M  Computer Concepks

The search results are divided into columns displaying the following attributes:

Attribute Description

Enabled / Disabled Displays * when an Object is currently disabled. Column is clear
(first column from left) | for enabled objects.

Status (second column | Displays the current status of the Object since the last commit, see
from left) Commit Dictionary Changes to Central Repository (vcroot) on
page 103. The following symbols appear, along with a color code
to represent the status of the Object:

+ with the name in green Added

— with the name in grey Deleted

~ with the name in magenta | Changed

? with the name in red In Conflict

Obiject Type (third Displays the icon indicating the object type.
column from left)

Name Displays the object name as specified in the section of the object.

Author Lists the ID of the user who last edited the object.
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Attribute Description
Last Edited Lists the date and time of the most recent edit.

Domain / Area

Displays the domain to which the object belongs.

Adjust Objects from the Dictionary Search Results

From the Find Objects Results window, you may access and modify Objects.

e Select one or multiple objects (using CTRL), and right click. An options menu

displays:

Dizable
Enakble
Delete
Dvikf
Fewert
Log
Renarme

Open
Disable
Enable
Delete
Diff

Revert
Rename
Export

Log

Opens the selected object(s) in a separate window.
Disables selected object(s).

Enables selected object(s).

Deletes selected object(s).

Highlights differences between the local version of the object(s)
and the version currently saved in the Central Repository.

Changes the selected object(s) back to the version saved in the
Central Repository.

Opens an Input window to enter a new name for the selected
object.

Opens an Export Selected Objects window from which you can
export selected objects to a .csv file.

Lists all of the log messages for the selected object(s).

Additional options display for Concepts:
Set/Unset Index Sets or Unsets the Index IML option for the selected

IML
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Concept(s). For more information see, Intelligent Search
Optimization Guide.
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Set/Unset Sets or Unsets the Openclass option. for the selected

Openclass Concept(s). For more information see, Intelligent Search
Optimization Guide

Set/Unset Set or Unsets the Subsumes option for the selected

Subsumes Concept(s). For more information see, Intelligent Search
Optimization Guide

Graph Opens the Ontology viewer for the selected Concept(s).

For more information see Ontology Viewer on page 31.

Commit Dictionary Changes to Central Repository
(vcroot)

The InQuira Dictionary uses a form of version control to allow multiple language users to
be able to login to the Language Workbench and work simultaneously. Therefore, InQuira
creates a copy of the central version of the dictionary for each user, referred to as the Local
Dictionary. Of these versions, the one that is used by InQuira Intelligent Search is the

Central Repository. As a result, a new Dictionary Object created by a user does not affect
Intelligent Search results until it has been committed to the Central Repository, or vcroot.

The Central Repository, or vcroot, is stored on the development environment at
<InQuira>\base\development\content\data\vcroot.

Only commit Dictionary Objects to the Central Repository after checking them fully using
Test Drive. For more information see Chapter 3, Test Drive. Before committing you may
choose to validate the dictionary in order to detect any possible errors. For more
information see Validate Dictionary on page 110

To commit to the Central Repository:

1. In Dictionary Manager, select Commit Work to Central Repository from the Tools
menu. The Confirm Commit Dialog displays.

Confirm Commit Ed

O —
)

- Enter a brief description of changes or reason for committing.
2. Click OK.
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The Commit process begins.

El Committing work to central repositony

___ ctepbeswipton |  Powess |

Ipdate Dickionaty
Commit changes ko Dickionary

There were no updates

The Dictionary Manager does not perform any other functions during the commit process,
since doing so could affect the data being transferred. During the commit process,
Dictionary Manager automatically:

e Tests for conflicts between the local data and the Central Repository data

e Checks whether you need to update from the central repository prior to committing
changes

e Updates each changed item in your local Dictionary

The Dictionary Manager does not commit changes if it detects a conflict. A conflict is
created when two users have checked out the central dictionary, made changes that
overlap the other, and one commits the change first. When the second user attempts to
commit, the dictionary detects changes have been made and a conflict is created. If
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conflicts are detected see Resolving Dictionary Conflicts, Commit Failed on page 106. If
Dictionary Manager does not detect any conflicts the following message displays:

Getting file statuses,

Getting file statuses.

Cornrmitting files for internallLanguage User,

Adding newly created files to version contral,

Cornrniting Y InQuira_8.0%instancest Demodevelopment’ content’ applications' default o
Updating runtirne data,

The commit was successiul

After a successful commit you must run a job in System Manager in order to see the
effects on live Intelligent Search results. If you have made changes to Concepts you need
to run both a re-index and synch job. However, if you made changes to Dictionary Objects
other than Concepts you can only run the synch job. For more information see Intelligent
Search Administration Guide.
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Resolving Dictionary Conflicts, Commit Failed

If Dictionary Manager detects conflicts during the commit process the following message
displays:

E.l Committing work to central repository

_ ctepDesaiptn |  Froges |

Update Rules, Alias Lists, Domains, & Users

Commit changes bo Rules, Alias Lists, Domains, & Users
Ipdate Concepts

Commit changes bo Concepts

Reload Concepts

Obtaining files initially,
Getting file statuses,

Getting file statuses,

Cornrnitting files for internaliuser,

Carnrniting 4 InQuira_B.0%instances Demodeveloprment’ content’ applications! defacltd
Updating runtime data,

There were conflicts updating your Concepts,

Fleaze resolve these conflicts and then try again.

HEE THE COMMIT FAILED ***

Upon selecting close, the Conflicts window displays.
Ak Conflicts _ | %]

I .S [N LV

noun.inguira.informat. .. | internalluser Dec 26 '07 3:53PM inguira
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To resolve conflicts:

1. Select a dictionary object from the Conflicts window. The Resolve Conflicts window
displays:

& Resolve Conflict

__ (1 ssvocenirlversin_|

CENMTRAL

infornation manager
im

The Resolve Conflicts Window compares your local version of the dictionary object with
the version already committed in the Central Repository. The differences between the two
are highlighted in yellow.

2. After reviewing the two select to save the local version or the central version. You may
also combine the changes or make additional changes in the local version and then
select Save local version.

3. Repeat this process until all conflicts have been resolved.

4. After all conflicts have been resolved select Commit Work to the Central
Repository. The commit process completes successfully.

Reviewing Dictionary Data Conflicts
Use the Conflict List to review conflicts prior to starting the commit process.
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To display the Conflict List:

1. Select Show unresolved conflicts from the Tools menu in the Dictionary Manager main
window:

¥ Dictionary Manager - Author: Administrator

‘:_L Show unrezalved conflicts

A

The Conflicts window displays the list of conflicts.

To resolve Dictionary data conflicts, follow the steps outlined in Resolving Dictionary
Conflicts, Commit Failed on page 106.
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Update Dictionary from Central Repository

Upon opening the InQuira Language Workbench your local version is automatically
updated with data committed to the Central Repository. It may be necessary for you to
update from the Central Repository during your Workbench session, especially if multiple
users are using the InQuira Language Workbench. Updating from the Central Repository
during your session keeps your local Workbench version consistent with changes that
have been committed by other Workbench users.

To update your local InQuira Language Workbench with data from the Central
Repository:

1. In Dictionary Manager, select Update from central repository from the Tools menu.
The Really update dialog displays:

Really update?

(2]

] o |

2. Select Yes.
The update process begins:

El Updating from central repositony ]
S 8%

pdate Dickionaty

Check Far Canflicks
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The Dictionary Manager does not perform any other functions during the update process,
since doing so could affect the data being transferred. During the commit process,
Dictionary Manager automatically tests for conflicts between your local version and the
central version. You must resolve all Dictionary Conflicts, see Resolving Dictionary
Conflicts, Commit Failed on page 106.

Validate Dictionary

The Dictionary Validation tool allows you to check for errors within dictionary objects
before committing objects to the Central Repository. The tool finds broken references
between objects, missing data, invalid values, and ontology relation loops.

To validate the dictionary:

1. From Dictionary Manager, select Validate Dictionary from the Tools menu. The
Dictionary Validation Setup window displays:
Dictionary Yalidation Setup

(2

Eﬂ

| |
|
||
| |
|
u
||
| |
|
||
||
|
L |
||
| |
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2. Select the Target Domain List you want to validate from the drop down menu.

If you want to validate objects not included in the selected Domain List, select
Validate Disabled Objects.

3. Select the dictionary objects you want to validate, or choose Select All.
4. Select OK. The Dictionary Validation window displays:

AL Dictionary Yalidation

Exception Lists
Spell Check Lists

Intent Hierarchies
Intent Responses
Response Templates

Process Wizards

Walidation for All Chjects of Selected Types

Alias Lists validation started.
- Found 3 alias Lists:
Alias Lists validation completed.

Concepts validation started.

The Dictionary Validation Messages section lists the number of a particular object found
and any errors associated with them. For more information regarding what validation tests
Dictionary Manager runs, see Dictionary Validation Tests on page 165.
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Reviewing Processed Workbench Modifications

The following table describes how to process modifications for viewing through
Information Manager:

Modification Steps to Process
Update concepts in the 1. Save.
Dictionary Manager tool in 2. Commit.
Workbench 3. Full Reindex of all collections and subsequent content

processing steps—Collection Maintenance, Classify (if
facets are used), Global Maintenance.

4. Mark Data task.
5. Synch to Runtime (or restart the indexer instance).
Update rules, intents, intent 1. Save.
responses, or alias lists in the 2. Commit.
Dictionary Manager tool in 3. Mark Data task.
Workbench 4. Synch to Runtime (or restart the indexer instance).
5. No reindex is necessary.
Update facet/taxonomy 1. Save (no commit necessary).
information in the 2. Run the Classify task (preferably as part of a content
Personalized Navigation tool processing task set that includes collection maintenance
in Workbench and global maintenance).
3. Mark Data task.
4. Synch to Runtime (or restart the indexer instance).
Update process wizards 1. Save (no commit necessary).
2. Mark Data task.

3. Synch to Runtime (or restart the indexer instance).

Update crawled content (such | Rerun content processing including Status Override, Content

as on the web or in IM) Update, Prep/Document Conversion, Index, Collection
Maintenance, Classify (if facets are used), Global Maintenance),
Mark Data task, Synch to Runtime (or restart the indexer
instance).

These steps initiate an incremental crawl which generally picks
up the change and is faster than a full crawl. If this doesn't pick
up the change, try repeating the steps and include a Content
Reset task (which clears all the previously crawled data from the
database and thus all data is crawled again).
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Modification Steps to Process

Change a channel's schema |Rebuild the channel's IQXML and do a full recrawl of the

in IM collection including Status Override, Content Reset, Content
Update, Prep/Document Conversion, Index, Collection
Maintenance, Classify (if facets are used), Global Maintenance,
Mark Data task, Synch to Runtime (or restart the indexer
instance).

If you have JMS disabled, you must restart IM to pick up the
changes to the channel schema.

Propagation Run the same steps in production that were recommended in
development, as outlined above.

NOTE: InQuira recommends asking questions to a runtime instance. InQuira does not
recommend testing changes by asking questions to the indexer instance other than
thru Test Drive. If you ask questions against an indexer instance, you should later
restart the indexer to clear out classes from memory that are used for question
processing but not needed for content processing, to avoid out of memory errors.

Import Dictionary Objects, Ontology Objects, and
Process Wizards

The following sections explain how to import Dictionary Objects, Ontology Objects, and
Process Wizards from an existing file into a current version of InQuira Intelligent Search.

IMPORTANT: Do not use the following procedures to perform upgrades.
If you are moving from an 8.0.x release to 8.1.2, you must follow the migration
procedure for ontology objects, as described in “Migrate Ontology Objects” and
“Migrate Non-Ontology Objects” in Upgrading InQuira version 8.1.2. The
procedures discussed in the following sections apply only to release 8.1.2 and later.

Importing Dictionary Objects

To import existing Dictionary Objects:

1. From Dictionary Manager, select Import Dictionary Objects from the Tools menu.

2. In the file finder, select the directory containing the .csv files containing Dictionary
Obijects and select Import.
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The Import Dictionary Objects screen displays:

Ril Impon Dictionary Objects

Imnpiork Aias Lists

Irmpork Inkents

Tnpeort Tnkent Hierachies
Import Intent Resporses
Irnpork Rules

Import User Profiies

Imported O Ajas Lists
Frished Importng alias Lists

Imported O Interts
Finiched Importing [ntents

Imported O Intert Hizrarchies
Firished Importng Intent Hierachies

Imported O Intert Resporees
Finished Importing [ntent Responses

Imported O Rules
Firished Importng Rules

Imported O User Profiles
Firished Importing Lser Profles

Importing Ontology Objects

Dictionary Manager provides commands for importing some ontology objects from .csv
files. You import all ontology objects together in one process. Before starting the import
process, place all of the .csv files together in one folder. The following list shows the
ontology objects and the associated .csv files:

e Concepts concepts.csv
e Clusters clusters.csv

e Synonyms synsets.csv

IMPORTANT: The files must use the name conventions as shown above. Dictionary
Manager does not recognize files and will not import files with other names.
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To import ontology objects:
1. From the Language Workbench menu, select Tools, Import Ontology Objects.
The Import Concept Objects window displays.

E Import Concept Objects E
Lok in: |E| cvs files LI i =

Dieskk op

4

My Documents

8

My Compuker

File name: IC:'I,Du:ucuments and SettingsiDefault Userlcws Files Import |
Files of bype: I LI Cancel |

2. Navigate to the folder containing the .csv files for import.
3. Click Import.

NOTE: The files may not appear in the Import Concept Objects window but, Dictionary
Manager locates the files when you click Import.
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The Import Ontology Objects window displays.

Step Description Progress I
Load Import Files 100%
Validate Concepts 0%
Validate Synsets 0%
Validate Clusters 0%
Add Concepts to Onkology 0%
Add Synsets to Ontology 0%
Add Clusters to Ontology 0%

Irnport Messages:

Finished loading import data from files

| | i

Save Log | Close |

Dictionary Manager then loads and validates the files. The Import Ontology Objects
window shows the progress of each task as it processes the task. If any exceptions
occur during the validation, Dictionary Manager displays the following dialog box:

Concept Mame: ¥ Window System

Mew Mame: ||

Marme SufFix; I

Ignore | Ignaore All |
Renarnme |
siffie | suffi el |

Feplace | Feplace All |

Merge | Merge All |

Zancel Impork |

Exception Options:

Option Description
New Name Enter a new name for the object and click Rename.
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Option
New Suffix

Ignore /
Ignore All

Rename

Suffix /
Suffix All

Replace /
Replace All

Merge /
Merge All

Cancel Import

Description (Continued)
Enter a new suffix for the object.

Click Ignore to ignore this object. Click Ignore All to have Dictionary Manager
ignore similar exceptions for objects being imported.

Click to apply the name entered above in New Name.

Click Suffix to apply the suffix entered in New Suffix above. Click Suffix All to
apply the same sulffix to all similar objects being imported.

Click Replace to replace the existing object with the one being imported. Click
Replace All to replace all similar exceptions with the objects being imported.
the same suffix to all similar objects being imported.

Click Merge to merge the existing object data with that of the object being
imported. Click Merge All to merge the existing data for all similar objects with
that of the associated object being imported.

Click to cancel the import process.

After all objects complete validation, Dictionary Manager adds them to the
application, completing the import process.

4. When the import process completes, click either Save Log or Close.

If you choose Save Log, Dictionary Manager prompts you for a file name and location

for the log file.

Exporting Ontology Objects

Dictionary Manager provides commands for exporting some ontology objects to .csv files.
The following list shows the ontology objects and the associated .csv files:

e Concepts
e Clusters
e Synonyms

To export concepts:

concepts.csv
clusters.csv

synsets.csv

1. Use the Dictionary Find Tool to locate the concepts to export.
2. Select all concepts from the Find Concept Results window that are to be exported.

Select all concepts: Right click on any concept and choose Select All from the
contextual menu.

Select multiple

concepts: Select a concept and then hold down the control key (Ctrl)

and click each additional concept to export.
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3. Right-click on a selected concept and choose Export from the contextual menu.
Dictionary Manager prompts for the file location and name.

4. Enter file location, accept the default name.
5. Click Export.

NOTE: When you export concepts, Dictionary Manager automatically exports the
synonyms (synsets. csv) file associated with the concepts that are exported.

Clusters
To export Clusters:

1. Use the Dictionary Find Tool to locate the clusters to export.
2. Select all clusters from the Find Clusters Results window that are to be exported.

Select all clusters: Right click on an item and choose Select All from the contextual
menu.

Select multiple clusters: Select a concept. Hold down the control key (Ctrl) and click
each additional concept to select.

3. Right-click on a selected cluster and choose Export from the contextual menu.
Dictionary Manager prompts for file location and name.

4. Enter file location, accept the default name.
5. Click Export.

Synonyms

NOTE: You can export synonyms with the associated concepts using the Concepts
procedure above. The following procedure exports only the synsets.csv file.
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To export synonyms:

1. Use the Dictionary Find Tool to locate concepts containing the synonyms to export.
2. Select all items from the Find Concept Results window that are to be exported.

3. Right-click on a selected concept and choose Export Synonyms from the contextual
menu.

Dictionary Manager prompts you to select the language.

4. Enter the file location, accept the default name.
5. Click Export.
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Dictionary manager displays a message saying how many synonyms were found and

exported.
Export Synonyms Summary E
': 1066 English synsets were Found and exported to
L] C:Documents and SettingsjpendletonDesktopsynonyms-gxportsynsets, csy
6. Click OK.

Import Process Wizards

To import existing Process Wizards to be used by your current version of InQuira
Intelligent Search:

1. From Dictionary Manager, select Import Process Wizards from the Tools menu. The
Import Process Wizards file finder displays.

2. Select the directory containing the .csv file containing Process Wizards and select
Import. The Import Process Wizards screen displays:

Ni Import Concepts

Import Shared Fields

Import Process Wizards

Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process YWizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard
Process Wizard

'Connection Problems' was successfully imported

'Double Eiling Diagnostic (IM)' was successully imported
Defect_8052" was successfully imported

'‘Conflicting transitions' was successfully imported

Defect 13734" was successfully imported

Defect_4905 Changed' was successfully imported

‘Lose other elerments when use Long Process Wizard Mame hikbkhlihblkbkRkinbkihkbkibkb' was successfull
'Double Biling Diagnostic' was successfully imported

“Water' was successfully imported

‘test’ was successfully imported

Mavigation Troubleshooter' was successfully imported

'Find the right phone for you' was successfully imported

'test’ was successfully imported

'RAC Breakdown Cover: Help me decide2’ was successfully imported
‘Retrieving Messages' was successfully imported

'Samnple_wWizard' exists; it wil be IGMORED

'Solaris 10 Process Wizard' was successfully imported

TestPW' was successfully imported

Imported 19 Process Wizards
Finishied Irnporting Process Wizards
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Chapter 3 Test Drive

Test Drive is a component accessed from within the Language Workbench that allows you
to test language processing and the effects of changes made in Dictionary Manager prior
to committing to the Central Repository and synchronizing. To access Test Drive see Test
Drive on page 15.

This Chapter explains:
e How to enter a query, Using Test Drive on page 122
e How to read the results, focusing on the following tabs used for Language Tuning:
- Rules Engine Tab on page 124
- Annotations Tab on page 126
- Unstructured Results Tab on page 135
- Structured Retrieval Tab on page 137
- All Messages on page 137
- XML Results on page 138
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Using Test Drive

122

To access Test Drive from the InQuira Language Workbench Launcher:

e Enter a valid User name and password

e Select Test Drive from the Application drop-down menu

To access Test Drive from other InQuira Language Workbench applications:

e Double-click on the Test Drive icon, displayed in the lower right corner of the main
application window

The Test Drive main window displays.

Upon opening Test Drive, the following screen displays:
P Test Drive

Mr- . B

e Enter a query in the Q: field.

(Optional) Select a Test Profile from the drop down menu. The default is Default. For
more on Test Profiles see Intelligent Search Optimization Guide.
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Select a Domain List from the drop down menu. The options listed reflect the default
language.

NOTE: Upon selecting the Language, the Domain List drop down menu changes to

reflect the selected language.

Select a Language from the drop down menu.
(Optional) Select a Subject from the drop down menu.

(Optional) Check the Concept Expansion box, if you have created new or modified
Concepts and want to approximate results without committing to the Central
Repository and reindexing. The Test Drive component automatically selects this
option when you have made ontology changes in the workbench. Concept Expansion
mimics what a fully-indexed system does with ontology changes and provides an
approximation so that testing can be faster since a full index across all content does not
need to be completed.

Concept Expansion expands into strings all concepts in the retrieval IML expressions
generated from a query into their synsets. When the Concept Expansion box is
selected, the search matches only concepts in single quoted strings; whereas with live
search, concept matching matches retrieval IML concepts that are annotated in the
content.

There are two main cases where a concept may not be annotated in the content:
1.1t corresponds to a range that is within a larger phrase.

The phrase “payment online” is contained within the phrase “bill payment online” so
“payment online”is not annotated. However, Concept Expansion finds both since it

expands all query concepts into their synsets, and the words “payment” and “online”
occur in the synsets.

2.1t is ambiguous and not preferred.

If a word is in two different base concept synsets (so these concepts are ambiguous
and not preferred), then neither of these concepts are annotated, and so search does
not find either one. Again, Concept Expansion finds both since it expands all query
concepts into their synsets, and the word occurs in the synsets.

NOTE: Test Drive results using Concept Expansion may differ from actual InQuira

Intelligent Search results. Concept Expansion simulates the effects of indexing
very closely, but not exactly. To see accurate results using Test Drive, it is
recommended you commit and reindex after creating a new or modified Concept.
If you are tuning with Test Drive, you must reindex and verify results either in the
Ul or in Test Drive with Concept Expansion OFF before concluding the real
impact of the tuning.
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e Select Ask.

Using Test Drive

Upon selecting Ask, Test Drive runs the query using InQuira Intelligent Search. The
search results are returned in a separate browser. The tabs located in the lower portion of
the Test Drive window now contain detailed information regarding your test query. The
following sections detail all available results tabs, however the most useful for InQuira

Language Tuning are:

- Rules Engine Tab on page 124
- Annotations Tab on page 126
- Unstructured Results Tab on page 135

Rules Engine Tab

|

Ii
Cu:unu:eptCu:unsI:ituent definition Base Standard

& |Global Yariables 2 English

& |Standard Search Definition Biase Standard

Gy [skiplist English

& [General Terms Variable English

& [VaR General Term Intent Library Customerhelp
& ScarchConcept Definibion Base Standard

&y [Tk Appearance S5 Base Standard

& [RequiredConcept Definition Base Standard

ey FeguiredConcept SC Base Concepk Appearance
&y [Security Plug in Admin

& |Launch Document Search English

The Rules Engine Tab lists all the Rules and Intents that matched the test query. The list is
separated into two columns: the Rule Name, and the Domain in which the Rule/Intent
belongs. The Rules/Intents are listed in the order in which they were matched by InQuira

Intelligent Search.

e Check the Show only company level rules to see Rules/Intents that are affiliated with

Company Level Domains.

124
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NOTE: It is recommended that you do not adjust rules other than those listed in Company
Level Domains, unless instructed to do so.

e To view or modify a matched Rule/Intent, double-click on the object. The Rule/Intent
displays in Dictionary Manager. For more information, please see Rules on page 69 or
Intents, Intent Hierarchies, Intent Responses on page 50.
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Annotations Tab

The Annotations Tab displays information regarding the words and phrases that occur in
the query and the Concepts associated with them.

After running Test Drive, select the Annotations tab. The Annotation tab displays:

e Select the Annotations tab to learn more about how InQuira Intelligent Search
annotated the query.

NOTE: The Annotations tab appears blank until an Annotation Type is selected.

For each Annotation Type, Test Drive displays annotations for the word displayed
with a white background in the Annotations Location. If no word is displayed with a
white background, the Annotations field contains all data associated with the query.

The annotation types considered the most useful for tuning are: Concept Synonyms on
page 127 and Search Component on page 132.
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Concept Synonyms
Upon selecting the Concept Synonyms, from Annotation Types, the following displays:

| High score concept: information manager

The Annotation Location highlights in red those words that have been annotated as
Concepts created in Dictionary Manager. Words appearing in black are not yet included in
the Ontology.

Under the Annotations field, appears the Concept Score for the Concept that appears in
the Annotation Location as red text with a white background.

e To view a matched Concept, double-click on the Concept Score listed in the field. The
Concept displays in Dictionary Manager. For more information on Concepts and
Concept Scores, please see Concepts on page 17.
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Label
Upon selecting the Label, from Annotation Types, the following displays:

Rules Engine.

nfrmation | manager |
!— NI

POS_MOUN
MY
' POS_MOUN
_ MP
FIRST_COMCEPT
. COMCEPT
CUSTOMER_LEYEL
' COMCEPTCOMSTITUENT
_ COMCEPTCOMSTITUENT
LEAD_IM
. STAMDARDSEARCH
SKIP

The Annotations field lists all the labels assigned to each word of the query.

e To view the labels associated with a particular word, select the word from the
Annotation Location. Once selected the word has a white background.

For more information on labels, please see Language Analysis Labels on page 168.
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No Concept Identified

Upon selecting the No Concept Identified, from Annotation Types, the following
displays:
Rules Engine.

The No Concept Identified type displays the word TRUE if the word selected from the
Annotation Location with the white background is not currently a Concept in Dictionary
Manager.

NOTE: Words that are labeled as skip words receive a value of true. Skip words are words
included on Skip Lists on page 129.

Skip Lists

InQuira Intelligent Search includes preconfigured Rules named Skiplist for each fully
supported language. The Rule contains a list of common words and phrases, such as
definite and indefinite pronouns, that are set to the global variable #skip. These words are
then “skipped”, or ignored by Intelligent Search during the matching process. Words that
appear on the Skiplist are not annotated with any concepts, nor are they used in triggering
Search Component Rules.
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Part of Speech

Upon selecting the Part of Speech, from Annotation Types, the following displays:

‘Rules Engine.

The Language Analyzer identifies and annotates the part of speech of words within both
queries and indexed content using the tags described in Part of Speech Annotations on
page 168
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Phrase
Upon selecting the Phrase, from Annotation Types, the following displays:

Rules Engine.

The Language Analyzer identifies and annotates the phrases within both queries and
indexed content using the tags described in Phrase Annotations on page 170
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Search Component
Upon selecting the Search Component, from Annotation Types, the following displays:

Rules Engne.

Unfometion | manager |

Texk Appearance SC: Importance=Trivial
ReqguiredConcept 5C: Importance=Required

Under the Annotations field, appears the Search Component Rules for the Concept that
appears in the Annotation Location as red text with a white background.
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e To view the details of how the Concept matched the Search Component Rule, double-
click on the Search Component Rule listed in the field. The Instantiated Search
Component box displays:

P Instantiated Search Component

R

("information” "manager”) IS (<information manager>)

{"information manager') IS {<information manager=}

{ <information manager=)

()

{"information manager')

The Instantiated Search Component box details how the highlighted Concept matches the
Search Component Rule and the points associated with that match. For example, the above
assigns: seven points when the literal phrase “information manager” appears in the result
and that match is annotated with the <information manager> Concept, six points when a
canonical match on “information manager,” such as “information managers”, appears in
the results and that match is annotated with the <information manager> Concept, five
points if any synonyms associated with the Concept <information manager> appears, and
three points for the key word match on “information manager”

e To view the Search Component Rule, select View Rule. The Search Component Rule
displays in Dictionary Manager. For more information, please see Rules on page 69.
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Stem
Upon selecting the Stem, from Annotation Types, the following displays:

Rules Engine.
_nformation | menage

information
]— manager

B —
—
_
_
:

Under the Annotations field, the stem, or basic unmarked form, of the selected word
appears. For more information on stemming, please see Concepts on page 17.
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Unstructured Results Tab

After running Test Drive, select the Unstructured Results tab. Unstructured Results refer
to the results that are returned from your company’s crawled content. The Unstructured
Results tab displays:

Annotations.

Festart the Infortnation hManager Serwice
Text Appearance S 7

Festart the Information llanager Service Festart the
Information WManager Service

o o o e e

.

. B

On the left-hand side, under Results, is a list of numbers.These numbers correspond to the
results displayed on the search results page after selecting Ask in Test Drive.

e Select a Number tab to view how many points were assigned to that particular search
results returned due to the Search Component Rules. Numbers correspond to the order
in which results appear on the search results page.

NOTE: The Unstructured Results tab appears blank until a number is selected.

For each number, Test Drive displays the Rules and Intents used to match the query with
the result in the Search Component field.
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Using Test Drive

e To see the Search Component Rules that did not contribute to the score of the
document, check the show unused box.

e To view the details of how the query matched the Search Component Rule, double-
click on the Search Component Rule listed in the field. The Instantiated Search
Component box displays.

For each number, the Unstructured Results tab in Test Drive displays the matched index
content associated with the result in the Index Result field. As you select a Search
Component Rule from the Search Component field, the text is highlighted red to represent
the words or phrases matched by the selected Search Component Rule.

The Unstructured Results tab also displays the excerpt that displays on the Search Results
page, for each number, in the Excerpt Result field.

The Unstructured Results Tab also includes the following information:

Field

Description

From Rule

Displays the name of the Rule that retrieved the selected
answer.

Collection name

Displays the name of the document collection in which the
answer is located. Document collections are defined within the
content acquisition process.

ID

Displays the ID number assigned to the answer source
document during the content acquisition process.

Document type

Displays the file type of the answer document, such as HTML
or PDF.

Scope type Displays the scope type associated with the matched answer.
Scope types include sentence, section, and document.
Range Displays the offsets, which indicate the positions of tokens

(words) within the index, associated with the beginning and
end of the Search Component scope.

Overall Score

Displays the overall score, which is calculated using weighted
averaging and normalization of the component search,
recency, and relevance scores.

Search Score

Displays the search score.

Recency Score

Displays the document recency score.

Relevancy Score

Displays the document relevance score.

Document Ranking

Displays a weighted average of links to the answer source
document.
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Structured Retrieval Tab

After running Test Drive, select the Structured Retrieval tab. The Structured Retrieval
tab displays:

If Test Drive has used a Structured database, then the Structured Retrieval tab displays:
e The SQL statement generated by the SQL Rule matched by the test query.
e The IML Statement used to restrict the SQL query results displayed.

All Messages

After running Test Drive, select the All Messages tab. The All Message tab displays:

Structured Retrisval

Fequest durnp for 4:
<message type="request":
<params:s

<param name="type" > AnswerQuestion < fparam:

<param name="Question"= information manager < fparam:=

<param narme="Transactionld" =4 < fparam:

<param narme="Priot TransactionId" =4 < fparar:

<param narme="ExpandIML"=»false< /pararn=

zparam narme="baselJRL" > file: f/C:\InQuira_B. 1hinguirafintf < fparam =

_Svctal | conyTodipboxrd |

The All Messages tab displays all messages written to the log file as a result of running
Test Drive. This information can be useful when troubleshooting InQuira Intelligent
Search.

o Select Select All and then Copy to Clipboard to save the messages.
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XML Results

After Running Test Drive, select the XML Results tab. The XML Results tab displays:

Al Messages

P message
[+ @ params

[+ @ responses
[+ @ Ffacets

[+ # constraint
[+ @ query
[ @ config

The XML Results tab displays the XML elements that make up the search results, and the
attributes associated with the XML elements. The XML elements appear under the
Structure as a tree structure.

e Select a node from the tree structure under message. Choose from:
- Parameter Element on page 138
- Responses Element on page 139
- Facets Element on page 139
- Constraint Element on page 139
- Query Element on page 139
- Configuration Element on page 139

Parameter Element

The XML results tab displays various parameter elements associated with the request and
the response. Request-related parameters include:

Name Value

type This value is the action completed. Usually “Answer
Question.”

Question This value is the text of the test query.

Transaction ID This value is the unique ID assigned to the request.
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Prior Transaction ID  This value is the unique ID assigned to the previous request
within the user session.

Expand IML This value is TRUE or FALSE.
Base URL This value is the Base URL of the returned results.
ProcessorVersion This value is the current version of InQuira being used.

Responses Element

The XML Results tab displays the Responses Element in a tree structure. By expanding
the tree structure, the Responses Element displays the purpose, title, link, and timestamp
for each answer returned on the results page.

Facets Element

The XML Results tab displays the Facets Element associated with the results. The Facet
Element uses a tree structure to display the available facets used within InQuira Intelligent
Search.

Constraint Element

The XML Results tab displays the Constraint Element. The Constraint Element includes
any factors used by InQuira to restrict results. The most common Constraint is language
that restricts with Domain Groups to use when returning results.

Query Element

The Query Element contains the test question in both the Original form and a Paraphrase.
The Original element is the original request as entered in the Ask field, whereas the
Paraphrase element contains the revised request as rendered and processed by the User
Interface.

Configuration Element

The Configuration Element includes the Search Within attribute that has a value of TRUE
or FALSE.
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Chapter 4 Quality Monitor

Quality Monitor is a component accessed from within the Language Workbench that
allows you to evaluate and monitor the quality of search results. You can use Quality
Monitor and the Grading Tool to analyze unsatisfactory search results, identify problems
with Dictionary Objects, gaps in your company’s content, and tune InQuira Intelligent
search accordingly. To access Quality Monitor see Quality Monitor on page 16.

This Chapter explains:

Using Quality Monitor on page 142
Test Profiles on page 146

Test a Question Set on page 149
Grade a Question Set on page 151

NOTE: Before using Quality Monitor you must configure the Quality Monitor data source

by accessing the Workbench menu with in the Advanced Configuration
Facility. For more information, please see Intelligent Search Installation Guide.
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Using Quality Monitor

Upon opening Quality Monitor, the following screen displays:
W Quality Monitor

i bvorkbench
Question Sets (00
: E Test Profiles

On the left side of the Quality Monitor screen is a tree structure. The tree structure is
separated into two parts:

Question Sets on page 143
Test Profiles on page 146
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Question Sets

e Select Question Sets. The Question Sets screen displays:
W, Quality Monitor

L warkbench
Il Ouestion Sats (0)

EErE

------ Ea Test Profiles

Add Question Set

Questions used in Quality Monitor are visible to Language Workbench users with the
Quality Monitor permission set. For more information, please see Intelligent Search
Optimization Guide. In order to keep question sets organized it may be helpful to create
various question set folders.

NOTE: InQuira recommends you create a Question Set hierarchy that is organized by the
Tuning Cycle, the date, and the name of the grader, for ease of reference.

To create a question set folder:

e Select Add Question Set from the Edit menu in the Quality Monitor window. The
New Question Set dialog displays:
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You may also select the Add Question Set option by right-clicking on Question Sets
from the left side of the Quality Monitor screen.

W/ HNew Question Set

e Enter a Name in the field, and select Add Question Set. The new Question Set name
displays in the folder structure.

W, Quality Monitor

Workhench

EIE‘E Question Sets (0)
2 )1y DLestion Set (0
| M Test Profiles

Import / Export Questions

Quality Monitor is used to grade a predefined list of queries. The queries are often taken
from the Popular Question report of InQuira Analytics, as this report lists the questions
most frequently asked by customers for a given time frame. For more information, please
see Using InQuira Analytics.

The following sections detail how to load user queries into Quality monitor:
- Creating a Question List to import on page 144
- Import Question Set on page 145
- Import Intent Questions on page 145
- Import Questions and Grades on page 145
- Export Questions and Grades on page 146
- Add a New Question Manually on page 146

Creating a Question List to import

In order to import a Question Set, you must have a list of predefined questions saved as a
txt file. If, for example, you are using the InQuira Analytics Popular Question report
saved as an .xIs file, you need to copy the questions into another program. Each question
must be on a separate line. Once this format is complete, save the file as a .txt file.
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Import Question Set
To import a question set:

e Select a Question Set folder from the left, and select Import Question from the Edit
menu of the Quality Monitor window. The Import Question List (UTF-8Encoding) file
finder displays.

You may also select the Import Question option by right-clicking on a Question Sets
folder from the left side of the Quality Monitor screen.

o Select the *.txt file stored on your local machine and select Import. The queries
appear in the Questions Tab, and the number of questions adds to the Question Set
folder display.

fccess Information. .. | untesked 1] 1] ofo afo o ofo o ofa

fccess Information. .. | untesked 1] 1] ofo afo o ofo o ofa

Configuring a web .., | untesked 1] 1] ofo afo o ofo o ofa

Howe do I skark Info,.. | untesked 1] 1] ofo afo o ofo o ofa

What is IM? urtested 0 0 ojo ofo ofo ofa
0 0

Wehat is Informatio,., | untesked

EErE |_ eS| Maran e |

Import Intent Questions

By selecting Import Intent Questions from the Edit menu, Quality Monitor enters all
questions listed as Test Question in an Intent into the Questions field. For more
information on Test Questions, please see Create a New Intent in the Intent Hierarchy on
page 58.

Import Questions and Grades

You may import previously graded Quality Monitor questions that have been exported
from an existing InQuira application. For more information, please see Export Questions
and Grades on page 146.

e From the Edit menu, select Import Questions and Grades. The Import Question
and Grades file finder displays.

o Select the folder containing the *.rtml file and select Import. The questions and
grades append to the Question Set.
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Export Questions and Grades

You may export a graded Question Set to review or import into an existing InQuira
application.

e From the Edit menu, select Export Questions and Grades. The Export Question
and Grades file finder displays.

e Select a location and enter a name for the *.rtml file. Select export. The questions and
grades save to the location specified.

Add a New Question Manually

In addition to importing questions as described above, you may also add a question
manually to be tested by Quality Monitor.

e Under the Questions tab of Quality Monitor, enter text into the New Question field,
push enter. The new question adds to the Question Set.

Test Profiles

146

Test Profiles are used to define specific testing environments within the Quality Monitor.
You can create and maintain any number of test profiles to simulate a particular type of
user context. For example, you can define test profiles with:

- Specific domains of Rule and Concept information.
- Separate supported languages.

- Specific user contexts or business conditions.

- Optional questions required to start a question set.

Using Test Profiles, you can also test response quality using your current local dictionary
instead of the Central Repository. For more information on the Central Repository, please
see Commit Dictionary Changes to Central Repository (vcroot) on page 103.

The Quality Monitor associates each set of test results with the test profile used for that
test, and maintains the test profiles as part of the test data. You cannot edit existing
profiles, and you can delete profiles only if they are not referenced by any test results.
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Select Test Profiles. The Question Sets screen displays.

i\ ok | Defak |Standard
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Create a New Test Profile

To create a new test profile:

e Select New from the Test Profile screen. The following window displays in the bottom
of the Test Profiles window:

e Enter a descriptive name in the Test Profile Name.

e Select a Language from the drop down menu.

e Select a Domain List from the drop down menu.

e (Optional.) Select a Subject from the drop down menu.

e (Optional.) Check the Use User’s Dictionary box, if you want to test the quality of
responses using dictionary objects stored in your local dictionary. Unchecked, Quality
Monitor tests responses using dictionary objects stored in the Central Repository.

e (Optional.) Enter Variable Settings.
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Using a context variable created in the Advanced Configuration Facility, see
Intelligent Search Optimization Guide, enter:

- The Variable Name.
- The Variable Value.
e (Optional.) Enter an initialization question(s).

Initialization Questions set parameters to set a user or business context, such as a user
profile, location, or product of interest. The Quality Monitor excludes the responses
from initialization questions from the test results set.

- Enter an Initialization Question in the New Question field.
- Select Add. The question displays in the Question field.
- Enter additional questions.

The Quality Monitor processes the initialization questions in the order in which they
occur in the list. You can use the arrows at the right of the initialization Questions field
to change the order of the questions as required to set the appropriate user context.

e Select Save. The Quality Monitor displays the new profile in the profile list.

NOTE: You cannot edit existing test profiles. Once you have used a test profile to generate
test results.

Delete a Test Profile

You can delete a test profile only if:

e It has not been used in a test.

e If it has been used in a test, then all results using the profile have been deleted.

To delete an unused profile:
e Select the profile from the Profile tab.
o Select the Delete button. The Quality Monitor deletes the selected process.

NOTE: The Delete process is immediate, there is no confirmation.

Test a Question Set

To test a Question Set after it appears in the Question tab:
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Select a Purpose from the drop down menu. Answer is the default selection. For more
information on purposes, see Purpose (portlet) on page 158

Define the Pass Criteria.

- From the drop down menus select the minimum number of Good answers and the
maximum number of Bad answers that may appear in the N Top answers.

NOTE: InQuira recommends setting the passing criteria to At least 1 Acceptable Answer

in the top 5 answers.

(Optional.) Select a Test Profile.

NOTE: Quality Monitor uses the test profile most recently used by your user ID as the

default. Verify the test profile, and select an alternate test profile if desired.

150

Use Ctrl + A to select all question is a Question Set, or highlight the desired questions
from a question set, and select Test or Test Question Set from the Edit menu of the
Quality Monitor window.Quality Monitor begins the test process. Information
regarding the progress of the test run is displayed at the bottom of the Quality Monitor
screen.

Answering queskion, . | 0%

You may also select the Test Questions option by right-clicking on a Question Sets
folder from the left side of the Quality Monitor screen.

After the testing process is complete, the Last Test Date and Test Count columns of the

Questions tab updates.
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Grade a Question Set

After a Question Set has been tested, you may grade questions using the Grading Tool. To
grade a question set:

¢ Highlight the questions to test from a question set, and select Grade. The Grading
Tool screen displays up to ten responses:
Grading Tool

Ciuestion Sets ANSWER =] ml
Access Information Center |

ﬂCCESEing the Information Center
Accessing the Information Center You can now access the
Information Center weh application by opening the appropriate
LUEL in a web browser, for example: http:fffindex?page=sample
vwhere:

Cuntentz
Contents Restart the Information Manager Service Accessing the
Information Center Managing the Information Manager Application
from Installation Configuration Environment

IE =l configuring Information Center Graphics and Formatting
. ® O Configuring Information Center Graphics and Formatting

IE Regiztering a Wehb Application

- W O Fegistering a Web Application You register a web application using
the Weh Application Management page of the Repository
managerment area, Use the configuration examples in this section
to register and deploy the Information Center sarmple application.

7 Cunfiguring a Web Application
0 Configuring a Web Application After this initial configuration, you |

e Using the set of radio buttons to the left of each answer, select the appropriate grade
for each answer.

NOTE: There are no standard criteria for assigning a grade to an answer; the grade for an
answer depends on criteria established by your organization, and the judgment of
the grader. For suggested grading guidelines please see the following section
Grading Guidelines on page 152.

e |faquestion appears to have no relevant answer, select the No Content box.
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NOTE: Once a question has been marked as having “No Content” the question is excluded
from the overall test results.

e Select the forward arrow at the top of the page to continue to the next question.

Quality Monitor immediately saves the assigned grades. You can change answer grades at
any time during the grading session, or during subsequent sessions.

Upon closing the Grading Tool screen, the grades for each question display in the Answer
Grades column of the Questions Tab. Additionally, the Test Runs tab displays the
percentage of questions that passed the grading criteria.

NOTE: InQuira considers 85% of the questions passing your grading criteria to be a well
tuned dictionary.

After the Grading process is complete, it is advised that you tune your dictionary using the
techniques discussed above in Chapter 2, Dictionary Manager and rerun Quality Monitor
to Compare Test Results on page 153.

Grading Guidelines

The following criteria are suggested as guidelines for determining the grade of a question
using the Grading Tool in Quality Monitor.

A Good answer meets one of the following conditions:

- It answers the question directly.

- It answers the question indirectly.

- It has a clear description indicating the linked page answers the question.
An OK answer has the following characteristics:

- It has a link that indicates the related page may have relevant information.

- It does not strike the use as a particularly good or bad answer according to the
specified guidelines.

A Bad answer meets one of the following conditions:
- Itis not at all related to the topic of the question.
- It makes the results appear to be a misunderstanding or malfunction of the search.

- It appears to be good, but the linked page does not contain the answer.
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Compare Test Results INQU IRA.

Analyze a Question Set

After a question has been tested you may select Analyze from the Questions tab. Upon
selecting Analyze the selected test question is processed using Test Drive. For more
information on Test Drive, please see Chapter 3, Using Test Drive.

Compare Test Results

To compare the answers to Question Sets of multiple test runs:
e Select the Test Runs tab. The Test Run tab displays:

e Using the ctrl, shift function select multiple Test Runs.

e Select Compare Answers. The Comparison of Selected Results tab displays at the
bottom of the Quality Monitor window.

491557 165353
12075 2473
27039 3034

20309 741
12465 1443
45357
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lNQumA,, Compare Test Results

Using the following color code, answer grades for the selected runs display:

Green Indicates a good answer.

Yellow Indicates an acceptable (Ok) answer.
Red Indicates a bad answer.

Cyan Indicates an ungraded answer.
White Indicates no answer.

e Check the Show Only Mismatches box to display only questions that have different
results are grades across the selected Test Runs.

Test History

The Test History tab displays the answers for the selected question in the Questions tab for
each Test Run:

2003-03-11 18:17:31 165555 AMSWER

e Using the Ctrl, shift function, select multiple Test Runs.
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lNQUlnA.,

o Select Compare Answers. The Grading Tool screen with the answers to the selected

runs displays:

4 Grading Tool

| Question Ses | s, [ [ ]

—
Access InFormation Center

| RuntGrade |  Runtdnswer [  RunzGrads | Runzanswer |

= accessing the
Information Center
&ccessing the
Information Center
O Can nowvw

access the

Information Center

weh application by

opening the

appropriate URL in

a web browser, for

example:

http: ff ffindex?page

=sample where:

SR I B IE

S I B IE

=l accessing the

Information Center
Accessing the
Information Center
YO can now
access the
Information Center
webh application by
opening the
appropriate LIREL in
a weh browser, for
example:

bttps ff ffindex?page
=zample where:

Contents
Contents Restart
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NS T N IE
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Appendix A Supplementary Tables

This chapter provides the supplementary tables and information to the previous chapters.
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INQUIRA. Purpose (portlet)

Purpose (portlet)

A purpose, also referred to as a portlet, corresponds to display characteristics
defined in the User Interface, enabling you to establish consistent, focused and
targeted presentation for various types of content. Choose from:

Answer Displays responses that directly address the user’s question in
the main results section.(Default.)

Act Displays links that provide actions that the user can take on the
web site.

Promote Displays cross-sell or up-sell advertisements for products
related to the intent of the question.

Related Topic Displays links to major topic categories defined for the web
site.

Define Displays links to terms used in the question as well as similar
content.

Jump to Page Displays content configured in the Dictionary for use with the
direct page display feature.

Converse Displays conversational response intended for use with a
virtual representative on the response page.

Feature Content Displays specific featured content from the web site that
supplements the answers.

Hidden HELP

Contact For use with the Contact Deflection feature.
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IML Basics

IML Basics

INQUIRAW

Define IML List Basic Operators

IML Color Code

The Dictionary object fields that accept IML input use a color code to aid in interpreting IML syntax.
The color code applies different colors to the various types of IML elements to aid in identification.

The color code may not be modified. The color code is as follows:

IML Element Color Assignment
Infix dark magenta
Prefix blue
Parenthesis red
Comma gray
Enumeration dark orange
Literal dark green
Assignment red
Keyword dark cyan
Label dark green
Concept dark blue
Unknown gold background

VIL expression

bright cyan background
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INQUIRA. Search Criteria Operators

Search Criteria Operators

You can use search criteria operators to match specified attributes of your definition
search criteria. You can specify string-related, date-related, and domain-related operators,
as described in the following tables:

String-Related
Operators
contains

exactly matches
starts with

ends with
Date-related
Operators

on any date/none
exactly matches
before this date

after this date

List Operators
any

is one of these

Description

Use this operator to locate items that contain the specified
string.

Use this operator to locate items that exactly match the
specified string.

Use this operator to locate items that begin with the specified
string.

Use this operator to locate items that end with the specified
string.

Description

Use this operator to locate items having any or no specified
date.

Use this operator to locate items having dates that exactly
match the specified date.

Use this operator to locate items having any date prior to the
specified date.

Use this operator to locate items having any date later than the
specified date.

Description

Use this operator to locate items having or belonging to any of
the parameters in the associated list.

Use this operator to locate items having or belonging to any of
the parameters selected from the associated list using the Set
tool.
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Search Criteria Operators

Specifying General Criteria

INQUIRA.M

You can specify the following general search criteria:

Field
Name

Notes

Author

Last Edited

Restrict results to
Active Domain List

Intelligent Search Language Tuning Guide

Description

Use this field to search for objects by name. Contains is
the default operator. You can use the following operators
to match specific attributes of the object name:

contains
exactly matches
starts with

ends with

Use this field to search for objects by text within the Notes
field. Contains is the default operator. You can use the
following operators to match specific attributes of the note
text:

contains
exactly matches
starts with

ends with

Use this field to search for objects by the ID of the user who last
edited the object. Any is the default operator. You can specify:

any

is one of these, using the Set tool to specify one or
more user 1Ds

Use this field to search for objects by the date they were
last edited. On any date/none is the default operator. You
can use the following operators to match specified
attributes of the date:

on any date/none
exactly matches
before this date
after this date

Check this box to restrict results to the Active Domain
List. If this box is not checked, Dictionary Objects from all
Domain Lists display.

161



INQUIRA. Search Criteria Operators

Specifying Concept-Specific Criteria

You can specify to search only for Concepts by selecting the Concepts radio button on the
Dictionary Find Tool window. You can further restrict the search by specifying the
following parameters:

Criteria Operator

Synonym Use this field to locate Concepts with synonyms that
match the specified string criteria.

Synset IML Use this field to locate Concepts with synonym sets that
match the specified string criteria.

Meaning Use this field to locate Concepts with Meaning data that
match the specified string criteria.

Score Use this field to locate Concepts at a specified level match
the specified string criteria.

Index IML Use this field to locate concepts with regards to the Index
IML setting.

Openclass Use this field to locate concepts with regards to the
Openclass setting.

Subsumes Use this field to locate concepts with regards to the

Subsumes setting.
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Search Criteria Operators

INQUIRA.,

Specifying Rule-Specific Criteria

You can specify to search only for rules by selecting the Rules radio button on the
Dictionary Find Tool window. You can further restrict the search by specifying the

following parameters:

Criteria
Question Conditions

Business Conditions
Answer Action text
Action type
Purposes

Methods

any

ary

any

any

any

ary

x| o o

Operator

Use this field to locate rules with question patterns or
example questions that contain the specified string.

Use this field to locate rules with business conditions that
contain the specified string.

Use this field to locate rules with Answer Action text that
contains the specified string.

Use this field to locate rules that contain the specified
action type.

Use this field to locate rules with assigned purposes that
match the specified criteria.

Use this field to locate rules with assigned methods that
match the specified criteria.

Specifying Intent or Intent Hierarchy-Specific Criteria

You can specify to search only for intents by selecting the Intent radio button on the
Dictionary Find Tool window. You can further restrict the search by specifying the

following parameters:

Criteria
Question Conditions

ary

-

Operator

Locate rules with question patterns or example questions
that contain the specified string.
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INQUIRA. Search Criteria Operators

Specifying Intent Response-Specific Criteria

You can specify to search only for Intent Response by selecting the Intent Response radio
button on the Dictionary Find Tool window. You can further restrict the search by
specifying the following parameters:

Criteria Operator

Language Locate intent responses in a specified language.

Template Locate intent responses based on specified templates.

Purposes Locate intent responses associated with specified answer
purposes.

Profiles Locate intent responses associated with a specified profile.
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Dictionary Validation Tests INQUIRA.

Dictionary Validation Tests

In addition to providing a count for how many of each dictionary object exists, the
Dictionary Validation Tool checks each selected dictionary object for errors.

For Alias Lists, the Dictionary Validation Tool tests:

The existence of specified root concepts.

The existence of specified context variables.

Whether a key has been duplicated.

The existence of referenced concepts.

Whether referenced concepts have been deleted.
Whether a key concept is a descendent of a root concept.

For Concepts, the Dictionary Validation Tool tests:

Whether a concept has associated synonyms.

The existence of concept loops.

For Domain Lists, the Dictionary Validation Tool tests:

The existence of a domain.

For Intents, the Dictionary Validation Tool tests:

Whether an intent has valid IML.

The existence of referenced variables.

The existence of referenced variables within the target Domain List.

The existence of referenced concepts.

Whether referenced concepts have been deleted.

The existence of referenced alias lists.

Whether a referenced alias list is not in the target Domain List, but the object is.
The existence of a concept referenced by VIL.

The existence of a global/local variable referenced by VIL.

Whether a parameter has a root concept.

The existence of referenced root concepts.

Whether a variable referenced by a parameter in an intent has been defined using IML.
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'NQU'RA~ Dictionary Validation Tests

166

For Intent Hierarchies, the Dictionary Validation Tool tests:
e The existence of a root node.

e The existence of a root node intent.

e The existence of referenced intents.

For Intent Responses, the Dictionary Validation Tool tests:

e The existence of a template.

e Whether there is a mismatch between field types.

e The existence of a referenced alias list.

e Whether a referenced alias list is not in the target Domain List, but the response is.
e Whether a referenced alias list is a concept property.

e Whether a referenced alias list is a context property.

e Whether a required field is not set.

e Whether a parameter is not a type of root concept.

e Whether a response with set parameter values is assigned to one or more intent(s).
e The existence of a referenced process wizard.

e The existence of a referenced profile.

e The existence of a referenced intent.

For Response Templates, the Dictionary Validation Tool tests:
e Whether there are no fields.

e Whether there is a field type mismatch

e Whether a required field is set in the response.

For Rules, the Dictionary Validation Tool tests the syntax:

e Whether an answer action is incomplete.

e Whether the rule has valid IML.

e The existence of a referenced variable.

e The existence of referenced variables within the target Domain List.

e The existence of a referenced concept.

e Whether a referenced alias list is not in the target Domain List but the object is.
e The existence of a concept referenced by VIL.

e The existence of a variable referenced by VIL.

Intelligent Search Language Tuning Guide



Dictionary Validation Tests

The existence of a preference that is not defined or configured to be used.

Whether an action points to an undefined purpose.
Whether a database action has a SQL query.

Whether the action has valid IML.

The existence of a variable for a glossary action.

The existence of a referenced plug-in.

Whether an exact answer has both an answer and a title.
Whether a URL action has a URL.

The existence of a referenced rule.

The existence of a referenced process wizard.

Whether a search component has a variable.

The existence of a search component variable.

Whether a search component local variable is defined in a rule condition.

Whether the search component has valid IML.

For Process Wizards, the Dictionary Validation Tool tests:

Whether the process wizard has steps.

Whether a step has no fields.

Whether a step has two or more fields named the same.
Whether a step has more than one search field.

Whether a step references an unknown shared field.

Whether a radio field has less than two options.

Whether a search field sets the same variable two or more times.
Whether a step has transactions from a search field.

INQUIRA.M

Whether a step has two or more transition conditions that are ambiguous (meaning

they have no fields in common).

Whether a step has two transitions that include the same condition.
Whether the transition from one step to the next has the same conditions.
Whether a transition from a step is missing a value in its condition.
Whether a transition from a step has duplicate conditions.

Whether a transition condition from a step references an unknown shared field.
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INQUIRAM Language Analysis Labels

Whether a transition condition from a step references an unknown shared value.

Whether a transition condition from a step references the same radio field more than
once.

Whether a transition condition from a step references an unknown field.

Whether a transition condition from a step references an unknown step.

Language Analysis Labels

The Language Analyzer assigns various types of labels, which are distinct from the

vari

able-related labels assigned by the Rules Engine. Labels assigned by the Language

Analyzer are generally notated in all capital letters. The following label types are

assi

gned:

Part of speech and bracketing labels. These labels use the part of speech tags described
in “Part of Speech Annotations” on page 168.

Orthographic labels, which include PUNCTUATION, CAPITALISED, ALL_CAPS,
and NUMBER.

Synset labels, which include FIRST_CONCEPT, and CONCEPT.

Scoring labels, which include BASE_LEVEL, INDUSTRY_LEVEL and
CUSTOMER_LEVEL. Scoring labels correspond to the synset score assigned in
Dictionary Manager.

The ANAPHORA label, which is added for concepts added during anaphora
resolution.

Part of Speech Annotations

NOTE: The Part of Speech Annotations are not configurable.

168

Annotation Description
CcC Coordinating conjunction
CD Cardinal number
DT Determiner
EX Existential there
FwW Foreign word
IN Preposition or subordinating conjunction
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Part of Speech Annotations INQUIR Al
Annotation Description (Continued)
JJ Adjective
JIR Adjective, comparative
JJS Adjective, superlative
LS List item marker
MD Modal
NN Noun, singular or mass
NNS Noun, plural
NNP Proper noun, singular
NNPS Proper noun, plural
PDT Predeterminer
POS Possessive ending
PRP Personal pronoun
PRP$ Possessive pronoun (prolog version PRP-S)
RB Adverb
RBR Adverb, comparative
RBS Adverb, superlative
RP Particle
SYM Symbol
TO to
UH Interjection
VB Verb, base form
VBD Verb, past tense
VBG Verb, gerund or present patrticiple
VBN Verb, past participle
VBP Verb, non-third person singular present
VBZ Verb, third person singular present
WDT Wh-determiner
WP Wh-pronoun
WP$ Possessive wh-pronoun (prolog version WP-S)
WRB Wh-adverb
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Phrase Annotations

Phrase Annotations

NOTE: The Phrase Annotations are not configurable.

Annotation Description

ADJP Adjective Phrase

ADVP Adverb Phrase

CONJP Conjunction Phrase

FRAG Fragment

INTJ Interjection. Corresponds approximately to the part-of-speech tag
UH.

LST List marker. Includes surrounding punctuation.

NAC Not a Constituent; used to show the scope of certain prenominal
modifiers within a noun phrase (NP).

NP Noun Phrase

NX Used within certain complex noun phrases to mark the head of the
noun phrase.

PP Prepositional Phrase

PRN Parenthetical

PRT Particle. Category for words that should be tagged RP.

QP Quantifier Phrase (for example, a complex measure/amount
phrase); used within noun phrases.

RRC Reduced Relative Clause

UCP Unlike Coordinated Phrase

VP Verb Phrase

WHADJP Wh-adjective Phrase. Adjectival phrase containing a wh-adverb,
such as how hot.

WHAVP Wh-adverb Phrase. Introduces a clause with a NP gap. May be null
(containing the 0 complementizer) or lexical, containing a wh-adverb
such as how or why.

WHNP Wh-noun Phrase. Introduces a clause with a NP gap. May be null

(containing the 0 complementizer) or lexical, containing some wh-
word, such as who, which book, whose daughter, none of
which, orhow many leopards.
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